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Introduction

Assisted Spatial Prioritisation Addressing Climate Effects (ASPACE) is an
assisted spatial prioritisation software conceived to support the design
and exploration of climate-resilient, socially acceptable and economically
viable marine spatial policy intervention scenarios. It combines climate
change modelling analyses, stakeholder value assessment, and economic
modelling together in an integrated, transdisciplinary, fully interactive tool,
designed to help meet the needs of policy makers and other practitioners,
as well as of researchers.

ASPACE is a free, web-based tool, that can be used in any marine and coastal
region where suitable datasets are available. ASPACE provides a number of
datasets to enable users to carry out analysis in some regions of the world,
but users can also upload their own datasets. Data uploaded by users can

be private or shared with the ASPACE community. As the ASPACE community
grows, our mission is to grow capability to manage our ocean around the world
in more sustainable and climate-resilient ways, for future generations.

ASPACE emerged from co-created scientific research in the United Kingdom
and other nations.
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1.1 Aims of the Tool

ASPACE was developed to advance the capability of Marine Spatial Planners
and others interested in marine space to make decisions which are evidence-
based and address climate change (i.e. that are climate-smart). Climate-smart
decisions seek to promote climate change adaptation for nature and people,
including nature-based climate change mitigation interventions.

ASPACE supports this aim by helping users identify and explore opportunities
for climate-smart marine spatial management via the development of
alternative spatial management scenarios that make use of climate-resilient
areas in our coasts and seas. Scenarios can then be compared based on the
areal extent of explored spatial uses that is climate-resilient, as well as on how
each scenario affects the blue economy of concerned regions, and how it aligns
with the values of their stakeholders (see Optimisation Option 2). The user can
also compare these scenarios with the current status-quo (see Optimisation
Option 1), to determine whether and which potential changes in spatial uses
(i.e. “interventions”) may be required to help build climate resilience in a way
that supports the economy of regions and values people hold about the sea
around them.

ASPACE was co-created with Marine Spatial Planners and
others involved in marine sectoral activities, with the aim
to improve their ability, and that of researchers, in creating
evidence-based, climate-smart decisions for marine space
management.

In this v1.0, ASPACE users can access and analyse state of the art ocean climate
modelling datasets and GIS data made available, to create scenarios in some
regions of the world, and score and compare them on climate resilience, economic
effects and alignment with social values. Users can also upload their own
datasets for use within the tool, and may choose to share them with the ASPACE
user community or to keep them private. ASPACE’s development will continue at
least until 2030, and updates will be communicated to registered users.

1.2 Who is ASPACE for?

ASPACE was co-created with Marine Spatial Planners and others involved in
marine sectoral activities, with the aim to improve their ability, and that of
researchers, in creating evidence-based, climate-smart decisions for marine
space management. Our users are government agencies, marine sectors, NGOs,
academia, and others interested in climate-resilient decision-making about
marine space.

1.3 What does this manual cover?

This manual for ASPACE v1.0 covers all essential functions and features of
ASPACE, as well as system requirements and troubleshoot, to help users get
started. It includes a quick-start guide as well as technical background on
main tool features and functions.
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Setting up

2.1 System requirements

- Supported operating systems: Windows 10, 11 or later. Ubuntu 20.04 or later

+ Minimum hardware requirements (CPU, RAM, storage): Intel Core i3, 8 GB, 60
GB or more.

« Network Requiremen:t The ASPACE Tool is a web-based application and
requires a stable internet connection for normal operation. Users must be
able to access the application over standard HTTPS (port 443). No special
network configuration is required for typical use. However, institutional or
corporate networks must allow outbound HTTPS traffic to the ASPACE domain
and associated services used for secure authentication, data upload, and
visualisation. For optimal performance, particularly when uploading large ZIP
files or interacting with spatial visualisations, a broadband connection is
recommended. If accessing the tool from a restricted network (e.g. behind a
firewall or proxy), users should ensure that web traffic to the ASPACE Tool is
not blocked or rate limited.

- Browser Requirements: Latest Google Chrome or Microsoft Edge or any other
Chromium-based web browser.

2.2 Installation & setup

No additional software or tools are required to use the web-based ASPACE Tool.
The application is accessible through any Chromium-based web browser, such
as Google Chrome or Microsoft Edge. Users should install and maintain their
browser using the standard installation and update procedures provided by the
browser vendor.
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4 Quick-start guide

3.1 Introduction

Welcome to the Quick-start guide. This contains everything you need to get
you started with ASPACE quickly. It focusses on the most common tasks
and essential actions to get you using ASPACE confidently. The contents
page contains direct links to each section allowing you to jump straight to
the information that you need. Screenshots are annotated to help guide you
through the key controls, reducing your guesswork and saving you time.

3.2 ASPACE workflow

The workflow below shows the grouping of the salient tasks to be completed
within ASPACE. It is split into four phases. The contents page is divided into
these phases to help structure your experience.

Preparing data Ocean climate Generating and Visualising, comparing
modelling analysis scoring alternative and downloading
spatial management alternative spatial

scenarios management scenarios

3.3 Data upload: formatting requirements
You do not need to upload data to use ASPACE. But if you would like to, here’s
how to do it:

By using this platform, you acknowledge that uploaded data is stored on
shared infrastructure and may be accessed by authorised developers for
system administration and support. Do not upload commercially sensitive,
confidential, or restricted information.
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Modelling data upload requirements

All modelling data must be placed within a single folder (directory),
which must then be compressed into a ZIP file before being uploaded to
the ASPACE Tool. The folder should contain modelling outputs organised
by year and structured to support 20-year comparative analyses. The
modelling approach assumes a fixed 20-year reference period, which is
compared against one or more 20-year future periods derived from the
dataset. The reference period must be clearly defined and must never
overlap with, or include, any years from the future periods. For example,

a reference period of 2006-2025 may be compared against rolling future
periods such as 2026-2045, 2027-2046, and subsequent windows; these
years are provided for illustration only. For each year-representing the first
year of a 20-year aggregation window, exactly three files are required to
summarise the model outputs: the mean (mn), sample size or count (n),
and standard deviation (sd).

All files must strictly follow the naming convention:

[PROJECT]_[CATEGORY]_[VARIABLE]_[YEAR]_[STATISTICS].txt.

with underscores (_) separating each element of the filename. For example:
FuMa-Portugal _EcospaceMapBiomass_Tunhas_2006_mn.txt,

FuMa-Portugal _EcospaceMapBiomass_Tunas_2006_n.txt, and

FuMa-Portugal _EcospaceMapBiomass_Tunas_2006_sd.txt.

Here, “_mn.txt” denotes the mean, “_n.txt” the sample size, and “_sd.txt” the
standard deviation.

How this aligns with the description

Period type Filename year 20-year window represented
Reference 2006 2006-2025
Future slice 1 2026 2026-2045
Future slice 2 2027 2027-2046
Future slice n 2079 2079-2098

Each modelling data file (.txt) must contain comma-separated regular spatial
grid data, where each row represents a horizontal slice of the spatial grid and
each comma-separated value represents a single grid cell. Numeric values
correspond to the modelled statistic for that grid cell, while NA indicates no
data (e.g. land areas, masked cells, or locations outside the model domain).
Zero (0) values are valid numeric entries and must be preserved as they
represent meaningful model outputs rather than missing data. All files must
contain data values only and must not include any headers, column names,
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or metadata rows. The spatial grid layout (number of rows and columns) must
be consistent across all years and statistics for a given dataset to ensure
correct temporal comparison and aggregation within the ASPACE Tool.

Spatial structure and coordinate requirements for modelling data

All datasets must be provided as spatially explicit time series in .txt. Each data
file must be structured as a numeric matrix representing the model domain,
where the matrix dimensions correspond consistently to the spatial grid (for
example, x = longitude and y = latitude). The spatial resolution and matrix
dimensions must be identical across all years and statistics within the same
dataset to ensure valid temporal comparisons.

The geographic coordinates of each grid cell must be supplied separately in an
accompanying longitude-latitude reference file (for example, lonlat.csv). This
file must contain two columns: lon and lat; which together define the spatial
coordinates of the model grid cells in the same order as they appear in the
modelling data matrices.

The lonlat.csv file must fully describe the spatial domain of the modelling data
and must remain consistent across all time steps and statistical outputs.

An example of the coordinate reference file structure is shown below:

lon,lat
-16.90747833,47.03308105
-16.90747833,47.13289642
-16.90747833,47.23271179
-16.90747833,47.33252716
-16.90747833,47.43234253
-16.90747833,47.5321579
-16.90747833,47.63197327
-16.90747833,47.73178864
-16.90747833,47.831604

Please note that ASPACE visualises data using the lat/lon coordinate as the
centre of the grid cell. If model outputs use lat/lon as the (e.g.) SW corner of
the cell, please amend the lat/lon file prior to upload to ensure that data aligns
correctly with the basemap in the tool

GIS layer upload requirements:

You do not need to upload GIS data to use ASPACE. But if you would like to,
here’s how to do it. The ASPACE Tool allows users to add custom GIS layers in
order to support spatial visualisation, analysis and scenario development. GIS
layers can be added using one of two supported methods:

1. Uploading a Shapefile (ZIP upload)
2. Providing an External WFS (Web Feature Service) link

Both methods are supported, depending on where your data is hosted.



ASPACE USER GUIDE

QUICK-START GUIDE 10

Option 1: Uploading a GIS Layer using Shapefiles (ZIP)

To upload a GIS layer to the ASPACE Tool, all required files must be placed
together within a single folder (directory), which must then be compressed into
a ZIP file prior to upload. The ZIP archive must contain the following mandatory
shapefile components:

.shp - Geometry data

.dbf - Attribute table containing feature properties

.shx - Index file linking geometry to attributes

.prj - Projection file defining the coordinate reference system (CRS)

All mandatory shapefile components must share the same base filename
to ensure the layer can be correctly read and processed by the ASPACE Tool.
For example:

ne_10m_land.shp
ne_10m_land.dbf
ne_10m_land.shx
ne_10m_land.prj

If the component layers of the shapefile do not have identical names, the data
may be interpreted incorrectly.

The use of a .prj file is recommended to ensure correct spatial alignment.
The ASPACE Tool is optimised for the EPSG:4326 coordinate reference system.
Layers provided in this projection will ensure maximum compatibility and
accurate visualisation.

Option 2: Adding a GIS layer using an external WFS Link
GIS layers hosted on external platforms (for example, EMODnet or other public
geospatial services) can be added using a Web Feature Service (WFS) link.

How to upload a WFS layer
- Select Source Type: “External URL”
- Paste the WFS GetFeature URL into the provided field

Example WFS URL (EMODnet):

https://ows.emodnet-seabedhabitats.eu/
geoserver/emodnet_open_maplibrary/
wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_
open_maplibrary:be000142&outputFormat=application/
json&srsName=EPSG:4326

Notes for WFS layers

- Publicly accessible URLs are required

« No authentication should be needed

+ The service should support GeoJSON output (application/json).
« EPSG:4326 is recommended for best compatibility


https://ows.emodnet-seabedhabitats.eu/geoserver/emodnet_open_maplibrary/wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_open_maplibrary:be000142&outputFormat=application/json&srsName=EPSG:4326
https://ows.emodnet-seabedhabitats.eu/geoserver/emodnet_open_maplibrary/wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_open_maplibrary:be000142&outputFormat=application/json&srsName=EPSG:4326
https://ows.emodnet-seabedhabitats.eu/geoserver/emodnet_open_maplibrary/wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_open_maplibrary:be000142&outputFormat=application/json&srsName=EPSG:4326
https://ows.emodnet-seabedhabitats.eu/geoserver/emodnet_open_maplibrary/wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_open_maplibrary:be000142&outputFormat=application/json&srsName=EPSG:4326
https://ows.emodnet-seabedhabitats.eu/geoserver/emodnet_open_maplibrary/wfs?service=WFS&version=2.0.0&request=GetFeature&typeNames=emodnet_open_maplibrary:be000142&outputFormat=application/json&srsName=EPSG:4326
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3.5 Userregistration

Assisted Spatial Prioritisation

C @ M «::.

|

° .
Enabling climate-
resilient Sustainable
Ocean Planning for the
future.

Sign in to account

Enter your email & password to login

Username

Don't have account? Cr

1. Navigate to
2. Pressthe “Sign In” button
3. Press the “Create Account” link



https://mspace.ac.uk

3.5 Userregistration

v

Fill in details
Read and agree to:
I. Terms and Conditions
IIl. Privacy Policy
Press the “Create Account” button

Create your accou nt
Enter your personal details to create an account.

Your Name

First name Last name
Company

Your organization

Country

Select your country

Email Address

xyz@example.com

Password

Your password must be at least 8 characters long, contain at least one digit, one uppercase letter, and one

special character.
Confirm Password

Agree with Privacy Policy and Terms & Conditions

Already have an account? Signin

Please check the junk folder for the registration email
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m Plymouth Marine Laboratory | x i )

cC @ p % mspace.ac.uk/index

\SPA( 85
GENERAL Welcome to the ASPACE Tool
() Dashboards v

| welcome

This is the Marine Spatial Planning Addressing Climate Effects (MSPACE) tool developed by Plymouth Marine Laboratory (PML).

Use the menu on the left to explore features that support climate-smart marine spatial planning.

APPLICATION

O Projects
23 iRrojects 2 Create new projects, continue existing analysis, o browse
5 shared project outputs
2 Modelling Data >
[¢ GIS Layers >
SUPPORT
/N FAQs & Important Documents
- Access essential documents, including the user guide,
£3 support Tickets >

terms and conditions, and privacy policy.

Torms & conditions | Privacy policy

« Overview of dashboard

- Simplifies navigation across tool

[ Modelling Data

Browse shared climate model or manage your own

modelling datasets.

© Need Help?

Check the FAQs or submit a support ticket - the PML team
will respond.

Create Tickst

Benjamin

User w

(@) / Dashboard / Welcome

[ GIS Layers

Explore spatial layers or upload and manage your own GIS

datasets




3.7 Read the documentation

m Plymouth Marine Laboratory | x i )

cC @ p % mspace.ac.uk/index

1.

\SPA( 85
GENERAL Welcome to the ASPACE Tool
() Dashboards v

| welcome

This is the Marine Spatial Planning Addressing Climate Effects (MSPACE) tool developed by Plymouth Marine Laboratory (PML).

Use the menu on the left to explore features that support climate-smart marine spatial planning.

APPLICATION

O Projects
23 iRrojects 2 Create new projects, continue existing analysis, o browse
5 shared project outputs
2 Modelling Data >
[¢ GIS Layers >
SUPPORT
/N FAQs & Important Documents
- Access essential documents, including the user guide,
£3 support Tickets >

terms and conditions, and privacy policy.

Torms & conditions | Privacy policy

Links to the User Guide, Terms and
Conditions and Privacy Policy can be found
under the “Important Documents” card.

[ Modelling Data

Browse shared climate model or manage your own

modelling datasets.

© Need Help?

Check the FAQs or submit a support ticket - the PML team
will respond.

Create Tickst

Benjamin

User w

(@) / Dashboard / Welcome

[ GIS Layers

Explore spatial layers or upload and manage your own GIS

datasets




3.8 Read the FAQs

m Plymouth Marine Laboratory | x i )

[[:I mspace.ac.uk/index

oo F Benjamin
User w
GENERAL Welcome to the ASPACE Tool Q) / Dashboard / Welcome
() Dashboards v

This is the Marine Spatial Planning Addressing Climate Effects (MSPACE) tool developed by Plymouth Marine Laboratory (PML).

I welcome Use the menu on the left to explore features that support climate-smart marine spatial planning.

APPLICATION

O Projects [ Modelling Data O GIS Layers
D) iProjeats 2 Create new projects, continue existing analysis, o browse Browse shared climate model or manage your own Explore spatial layers or upload and manage your own GIS
< shared project outputs. modelling datasets datasets
2 Modelling Data >
[¢ GIS Layers >
SUPPORT
/N FAQs & Important Documents © Need Help?
- Access essential documents, including the user guide, Check the FAQs or submit a support ticket - the PML team
£33 support Tickets > i .
terms and conditions, and privacy policy. will respond.

Terms & conditions | Privacy olicy Create Ticket

General
2 @ what is the ASPACE Tool?
® Do I need to install any software to use the tool?
@ s the tool free to use?
(® What are the network requirements?
@ Where can | find or download the User Guide?
® Where can | find or download the Privacy Policy?
@ Where can | find or download the Terms & Condition (Permission to use content)?

1. Navigate to the FAQ tab
2. Review the FAQs by pressing on the title
and expanding the dialogue box
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~v DB Plymouth Marine Laboratory | | X+

25 mspace.ac.uk/create-ticket

GENERAL

Dashboards

APPLICATION

Projects

Modelling Data

GIS Layers

SUPPORT

FAQs

{3 Support Tickets

uUsers' Tickets
My Tickets

Create Ticket

Create Ticket

Ticket Title

Ticket Description

Ticket Type Priority

Bug Report v Low

Attach Files (If required, please select multiple files)

Choose files  No file chosen

Navigate to the “Create Ticket” tab under
the “Support Tickets” tab

Fill in the details

Press the “Add” button

The ASPACE team will review your ticket

and get back to you promptly

Benjamin
user w

Gancel



3.10 Review tickets raised

~v DB Plymouth Marine Laboratory | | X +

C M 23 mspace.ac.uk/my-tickets

GENERAL My Tickets (R / Ticket / MyTickets

Dashboards >

My Ticket List

APPLICATION List of ticke
01 Pending 0 0 Closed
Projects »
Maodelling Data >
GIS Layers > TI001 Ben's First Ticket Other / General Enquiry Low Pending
SUPPORT |
FAQs

{3 Support Tickets v

uUsers' Tickets
My Tickets

Create Ticket

1. Navigate to the “My Tickets” tab under
the “Support Tickets” tab
2. Review any tickets that you have raised

with their progress
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3.11 Uploading ocean climate
modelling data

A4 i Plymouth Marine Laboratory | x +

23 mspaceacuk/s

) - oo Benjamin
O o g V user w
GENERAL Shared Mode“ing Data () ! Shared Madelling Data [
~) Dashboards >
Shared Modelling Run List
APPLICATION View different modelling scenarios and ecosystem servicks shared by others
Projects » —
9 Total Modelling Runs Search by Name or Code
® Modelling Data ~
My Models
Reference: ol
GIS Layers >

FuM T48 PortugueseEEZ 5 =

M8 FuMa T44 PortuguessEEZ ki 15-07-2025 18:32 (w1l Modelling Runs Ecosystem Services @ About

SUPPORT Reference: Co.
FuMa T4 Northwest FuMa T44 Northwest a
&y FAQs wiar - - N » 1507-2025 1500 [ modelling Runs h ecosystem services @ about
Mediterranean Sea Mediterranean Sea
3 Suppoert Tickets >

FuMa T4 North Sep Reference S &

M08 FuMa Téd North Sea i 2 15072025 13.57 [ Modelling Runs Ecosystem Services | © About
coll..
Ecopath with Ecosim (Rikka

Mi0s FulureMares Archipelago Sea = e 3 10-07-2025 1748 [ Modelling Runs B Ecosystern Services @ About
Puntila-Do
ERSEM Simulates ma ? =

M3 ERSEM and 55-DBEM & 24-04-202515:52 @ Modelling Runs Ecosystem Services
biogeochemic
Astate-of-the-art model that .

Mio2 55-DBEM 1-03-2025 16:05 Elj Modelling Runs h Ecosystem Services @& about
projects ¢
Simulates marine biogeochemical z &

w01 Ersem o8 1-03-2026 15:44. [N ModellingRuns | [ Ecosystem Services | @ about
cyeling _

You do not need to upload modelling data to use My models: modelling data uploaded by the user.
ASPACE. But if you would like to, here’s how to do it.
Shared models: modelling data uploaded by ASPACE
1. Navigate to the “My Models” / “Shared Models” team or other users, for shared use in
tab within the “Modelling Data” tab the platform.

<— Back to quick start contents



3.11 Uploading ocean climate
modelling data

~ i Plymouth Marine Laboratory | | X +

2% mspaceac.uk/n

= Benjamin
oo 1 > User w
GEMERAL Mndelling Data G / Modelling Data / My Mc
Dashboards >

My Modelling Run List

APPLICATION adelling d ecgsystem services

Projects »

0 Total Modelling Runs Sear

y Name or Code

&)

B

Modelling Data -

My Models

Shared Models Mo madelling data found

GIS Layers >

SUPPORT

FAQs

3 Suppoert Tickets >

To upload your own modelling dataset(s):

1. Navigate to “My Models”
2. Press on “Add Model” button



3.11 Uploading ocean climate
modelling data

~ i Plymouth Marine Laboratory | | X +

m [0 % mspaceacuk

a Benjamin
oo User w
GENERAL Add Modelling Data Q { add f
Dashboards >

APPLICATION
Source Model
Projects »
Modelling Data > o
Model Description *
GIS Layers >
SUPRORT 2
FAQs 5
Upload CSV File (Longitude, Latitude) *
Support Tickets >

Choose file  No file chosen 3

1. Read the formatting rules for new

modelling data upload
2. Fillin the form
Attach CSV file
4. Press “Add Modelling Data” button




3.12 Viewing details of ocean
climate modelling data

~ ﬂ Plymouth Marine Laboratory | | X 5

23 mspaceacuk/s

o Benjamin
oo User w
GEMERAL Shared Modg“ing Data () / Shared Modelling Data | Mi02 [ Scenarios
Dashboards >

Scenario List

APPLICATION View modelling scenarios shared globally for this model

Projects »
5Total Scenarios Search by Name or Code

® Modelling Data ~

My Models
Shared Models =
MS133 T Wiestern Med World Market RCPES T44 Western Med World Market REPBS Re. 17-07-2025 14:20:26 E variables @ About
GIS Layers >
Ms132 T44 Western Med Status Quo RCPES T44 Western Med Status Quo RCPES Refe.. 7-07-2025 14:10:22 = varisbles ® About
SUPPORT

FAQs MS131 T44 Western Med Status Quo RCP26 T44 Western Med Status Quo RCP26 Rele. 7072025 13:58:07 = variables @ About

3 Support Tickets y =
MSI30 T44 western Med Global Sustainabilily RCP26 T44 Weslerm Med Global Sustainability RC 7-07-2025 13:40:02 E= variables ® about
MS129 T44 Waslern Med Nalional Enterprise RCPBS T44 Weslern Med Nalional Enterprise RCPB. 17-07-2025 11:23:56 E variables @ About

Showing | to 5 of 5 scenarios.

1. Under the model of choice press the “Variables”
button to highlight which variables are used for the
climate modelling and their direction

2. Under the model of choice press the “About” button

to provide details about the modelling datasets
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3.13 Uploading economic
modelling data
Coming soon!

3.14 Viewing details of
economic modelling data
Coming soon!

3.15 Uploading social values data
Coming soon!

3.16 Viewing details of
social values data
Coming soon!

3.17 Integration with the Offshore
Renewable Impacts on Ecosystem
Services (ORIES) project

Coming soon as part of the EQUIFy project

<— Back to quick start contents

25
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3.18 Adding GIS layers

v BB Plymouth Marine Laboratory |1 X +

[[] 25 mspace.ac.uk/my-gislayer-category/

=
oo
GENERAL GIS Layers
Dashboards >
My GIS Layer Categories
TR Manage your GIS layer categories and assaciated
& Projects >
2Total Categories
Modelling Data >
@ GiIs Layers v
My GIS Layers Gem Planning Arsas

Shared GIS Layers

Geno Habitat Layers
SUPPORT
Showing | to 2 of 2 category/s
4 FAQs
3 Support Tickets > LY

You do not need to upload GIS data to use
ASPACE. But if you would like to, here’s how
todoit

1. Navigate to the “My GIS layers” / “Shared
GIS layers” tab within the “GIS layers” tab

Planning Areas

Habitats

Benjamin

() | MyGIS Layer Categories

Search by Name or Description

13-10-2025 19:24:34 Mais Layers [ dit
SR .-

My GIS layers: GIS layers uploaded by the user.

Shared GIS layers: GIS layers uploaded by the ASPACE
team or other users, for shared use on the platform.



3.18 Adding GIS layers

v BB Plymouth Marine Laboratory |1 %

[[] 25 mspace.ac.uk/my-gislayer-category/

- ot Benjamin
" 0o User w
GENERAL GIS Layers Q) / MyGIS Layer Categories
Dashboards >

My GIS Layer Categories 1
Manage your GIS layer categories and associatoed layer

APPLICATION

Projects »
2Total Categories Search by Name or Description

Modelling Data >

@ GiIs Layers v

My GIS Layers Gem Planning Areas Planning Areas 13-10-2025 192834 @GISInyers r’) Fdit B Delete

Shared GIS Layers

ceno Habitat Layars Mabitats 13-10-2025 18:01:50 Mais Layers [# edit il Dolete
SUPPORT

Showing | to 2 of 2 category/s
£\ FAQs

[ ?:.i

3 Support Tickets > e

1. Press the “+ Add Category” button—This will
create a category where your GIS layer will reside
2. Fillin the form
Press Add Category button



3.18 Adding GIS layers

~v DB Plymouth Marine Laboratory | | X

1]

25 mspace.ac.uk/my-gislayer-category/

GENERAL
Dashboards
APPLICATION
Projects
Maodelling Data
@ GiIs Layers

My GIS Layers

Shared GIS Layers

SUPPORT

FAQS

3 Support Tickets

»

»

Benjamin

GIS Layers @ | MyGIS Layer Categories

My GIS Layer Categories
Manags your GIS lay i

2Total Categories Search by Name or Description

Gem Planning Areas Planning Areas 13-10-2025 19.24:34 @GIS Layers Ivj Fdit B Delete
ceno Mabitat Lsyars Mabitats 13-10-2025 180150 Mais Layers il Dolete

Showing | to 2 of 2 category/s

Your newly created category will appearin

the table

Press the button “GIS layers” for your newly

created category



1.

3.18 Adding GIS layers

~v DB Plymouth Marine Laboratory | | X

GENERAL
Dashboards
APPLICATION
Projects
Modelling Data
@ ais Layers

My GIS Layers

Shared GIS Layers

SUPPORT

FAQS

3 Suppoert Tickets

1]

°

GIS Layers
GIS Layer List

0 Total GIS Layers

2% mspace.ac.uk/my-gislayer-cateqoi

Benjamin

Q ! Mycs

ayer Category | GG

Wo GIS layers found

Check the formatting guidelines for GIS layers

2. Press the Add GIS layer button



3.18 Adding GIS layers

v Bl Plymouth Marine Laboratory |1 X +

25 mspace.ac.uk/gis-la

Add GIS Layer

APPLICATION Upload shapefile ZIP or provide an external URL for a new GIS layer.
2 Projects >
d GIS Layer Name
(5 Modelling Data >
) GIS Layers > 1
GIS Layer Description
SUPPORT
N\ FAQs &
s Select Category
§ Support Tickets >

-- Select Category -~ v

Select GIS Layer Types
Biodiversity
Biosecurity
Conservation 2
Cultural Heritage
Economy
Energy

Hold Ctrl (Windows/Linux) or Command (Mac) to select multiple types.
Source Type

ZIP Upload e

Upload Shapefile ZIP

Choose File no file selected 3

1. Fillin the form

2. Multi-select the “Layer Types” that are appropriate
for your GIS layer by holding down the “Ctrl” button
on your keyboard

3. Attach the shape file

4. Press on the “Add GIS layer” button



3.19 Using GIS layers

~v DB Plymouth Marine Laboratory | | X

[I] 25 mspace.ac.uk/shared-gislayer-cateqg

Benjamin
= ag User w
GENERAL GIS Layers () / Shared GIS Layer Category / GC123
Dashboards >
GIS Layer List
APPLICATION Browse GIS layors shared globally under the selected catagary
Projects »
1Total GIS Layer h by Nar r Typ
Modelling Data >
@ GiIs Layers v

My GIS Layers GLIS8 Global wracks and obstructions - UK Hydrographic Dffice An extens ve data set contsining over 84,000 char. FILE 13-01-2026 12:56.31 Y Default Filter @ about

Shared GIS Layers
Showing 1 to 1 of 1 layers

SUPPORT

FAQS

3 Suppart Tickets >

1. To find out more information about the
default filters used for the GIS layer press
the “Default Filters”



1.

3.19 Using GIS layers

~v DB Plymouth Marine Laboratory | | X

[I] 25 mspace.ac.uk/shared-gislayer-cateqg /la /default-filter/

& oo
GENERAL GIS Layer Default Filter
Dashboards >
Add/Edit Default Filters
APPLICATION Set filter mode and add one or more column filters for the selected GIS layer.
Projects 5 GIS Layer Category
GC123 - Wrecks and obstructions
Madelling Data >
Filter mode
@ GiIs Layers v
RlatsiLayets Quick action
Shared GIS Layers |
Saves colunn_to_filter: "all” and keywcrds_ta_fllter: ["all")
SUPPORT
&y FAQs Column Filters
B SupportTickees > Calumn Filter Name
g, Select Carnwall port
Column

Select a column...

Active filters

This page will detail the Filters that are applicable to
the GIS layer. These filters will be the defaults for any
ASMS generation that involves this layer if the user
chooses to use it with when creating ASMS via the
Basic Wizard.

Benjamin
user w
() ! Shared GIS Layer Category / GGI23 / GIS Laye GLISE [ View Filter
GIS Layer
GL158 - Global wrecks and obstructions - UK Hydrographic Office
or rationale
“
Values
-5 a column fir .
v
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3.19 Using GIS layers (continued)

v BB Plymouth Marine Laboratory |1 %

25 mspace.ac uk/shared-gislayer-cateq

GENERAL GIS Layerg () ! Shared GIS Layer Category / GC123 [ GIS Layers

%) Dashboards >

GIS Layer List

APPLICATION Browse GIS layers I the selected cat
& Projects »
1 Total GIS Layer S Rari by Hame: Cada o Tie m
Y Modelling Data »
@ ais Layers v

My GIS Layers GLISE Global wrecks and obstructions - UK Hydrographic Difice A extens (ve data set containing over 84,000 char FILE 13-01-2026 12:56:31 ?nclma\r Filter @ About

Shared GIS Layers
Showing 1 to 1 of 1 layers

SUPPORT
& FAQs

3 Support Tickets >

O,

GIS Layer# GL158

Layer Name

Global wrecks and obstructions - UK Hydrographic Office

Description

An extensive data set containing over 94,000 charted,
uncharted, live and dead wrecks and obstructions from
around the world. Downloaded from UKHO
https://datahub.admiralty.co.uk/portal/apps/sites/#/ma et

Created On

Jan. 13, 2026, 12:56 p.m.

Source Type

FILE

Layer Types

Tourism

Cultural Heritage
Recreation

1. To find out more information about the GIS layer
including referencing details press the “About” button

2. This dialogue box will provide an overview of the
information for the GIS layer including: Name,
Description, Creation date, Source Type and Layer Types

In order to visualise GIS layers please follow the
instructions described in Analysis IV—0verlaying GIS

layers of interest

<— Back to quick start contents



3.20 Analysis I—Creating a new project

v Dl Plymouth Marine Laboratory | | X+

25 mspace.ac.uk/projects/

GENERAL Projects | ¥

Dashboards >
Project List
APPLICATION View existing projects or create a neéw one.

& Projects v
3 Total Projects Search by Name or Code

My Projects

Shared Projects

Madelling Data >
P13 ERSEM EDE - Dptimisation Pathway Test ERSEM EOE - Optimisation Pathway Test 13-10-2025 16:02.25 M Activities Mview Outputs
2 GIS Layers >
14z Northern Ireland casa study Northern Ireland conservation (benthic habitats) 13-10-2025 15:26:10 Mactivities | [Mview outputs
SUPPORT
FAQs P10 BOD_ERSEM_NL_Test BOD_ERSEM_NI_Test 13-10-2025 12:30:48 (M Activities M view Outputs

1 Suppaort Tickets > Showing | to 3 of 3 projects.

1. Projects are how individual analysis My Projects dashboard shows a list of analysis
workflows are identified in the ASPACE workflows created by the user
platform.

Shared Projects analysis workflows created by the
ASPACE team or other users, for access by all on the

platform



3.20 Analysis I—Creating a new project

v BB Plymouth Marine Laboratory |1 %

25 mspaceacuk/p

- Benjamin
-
il 2 Raers

GENERAL Projects Q) / MyProjects
Dashboards >
Project List

APPLICATION ting projects or create a new one

& Projects v
3 Total Projects Search by Name or Code

My Projects

Shared Projects

Madelling Data >
P13 ERSEM EDE - Dptimisation Pathway Test ERSEM EOE - Optimisation Pathway Test 13-10-2025 16:02.25 M Activities Mview Outputs
GIS Layers >
14z Northern Ireland casa study Northern Ireland conservation (benthic habitats) 13-10-2025 15:26:10 Mactivities | [Mview outputs
SUPPORT
FAQs P10 BOD_ERSEM_NL_Test BOD_ERSEM_NI_Test 13-10-2025 12:30:48 (M Activities M view Outputs

[ Support Tickets > Showing 1to 3 of 3 projects.

1. Read the section on Meta—Analysis in the User
Guide which explains the analysis framework used
in the tool

2. Press the “+ Add Project” button



3.20 Analysis I—Creating a new project

~v DB Plymouth Marine Laboratory | | X +

[[] 25 mspace.ac.uk/projects/add/

=
= Benjamin
0o User w
GENERAL Select Project Area Q / Project
Dashboards >
+
APPLICATION -
& Projects v e { Canigs
L \ Oslo D > Nerepfypr
> elsink
Fe?d { 2
My Projects / Stockholm E
Shared Projects 0 4‘*\
{ L
Madelling Data » L Dapmark
Onited |nqdl‘)(m Uatuv Mocxsa
GIS Layers » Giear Britain
, . B
Eire / Ireland , ! ‘Beriin
SUPPORT wndonﬂ }Jmpmns y
- }'" Dautschia
y FAQs ¢ ‘;Fam Eesk Knia
. vensk
T Suppert Tickets y X Chisindu
—" 3y | @
® Zagreb J
HGTa  'cp6u)s
B
Barcelona Itali
e
. £ 8 ey tpuwbe “Azarbayean
p bD W » ANG fzmr iy
f S g Antalya
ba T . oy
[oTHY: LN Ager s}
B AXo3H0 x
® e
ol
Lfatany Lgasol
salall Phghem N /g

1. Navigate to the region of interest
2. Use left click on your mouse to Drag

and Drop your area of interest.
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3.20 Analysis I—Creating a new project (continued)

v BB Plymouth Marine Laboratory

Step 1: Select a Model

£ M101 - ERSEM

O m102 - $5-DBEM

® M103 - ERSEM and SS-DBEM

1. Select the Model (modelling dataset) of
interest. This can be one of your datasets
or a shared dataset.

2. Press the “Next” button.

<— Back to quick start contents
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3.20 Analysis I—Creating a new project (continued)

v BB Plymouth Marine Laboratary |+ X

m [ 23 mspace.ac

0 Step 2: Select a Scenario

L) MSI0S - MSPACE - ERSEM & FISHERIES 4.5

® MS106 - MSPACE - ERSEM & FISHERIES 8.5

If you click on back button, you will lose recent changes done on this page.

Seneel “ “

1. Select the dataset for the Greenhouse
Gas Emissions Scenario or other
Scenario available, of interest.

2. Press the “Next” button

<— Back to quick start contents

39
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3.20 Analysis I—Creating a new project (continued)

v BB Plymouth Marine Laboratory

Step 3: Select Variable Trends

Variable Trend
available-refractory-carbon Decreasing
bottom-organic-carbon Increasing
bottom-oxygen Increasing

battom-ph Decreasing
bottom-salinity Increasing
bottom-saturation-state-aragonite Variable Not Selected

v

If you click on back button, you will lose recent changes dene on this page.

HnseeeAl n “

1. Review the individual variables available in the selected dataset
by scrolling down, and select them by using the expected
climate change trend using the drop down menu.

2. To select a variable, a trend must be selected. This step of the
analysis is very important and should be taken with care as it
affects the overall outcomes: please refer to the Meta-Analysis is
section of the user guide for detail.

3. If using datasets uploaded by the ASPACE team, several or all
variables available will have already be presented with their
expected climate change trends for the region, but these can
also be modified by the user in their present workflow, if they
have different information.

4. To unselect variables, use the dropdown menu.

5. Once you have selected all (and only) your variables of interest
and entered their expected climate change trend in the region of
analysis, press the “Next” button.

<— Back to quick start contents
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3.20 Analysis I—Creating a new project (continued)

v BB Plymouth Marine Laboratory

Step 4: Enter Project Details
Project Name
Test Project1

Project Description

Project Description 1

Select final time slice for meta-analysis Selected number of time slices

2050 - 2089 as

N I

1. Enter the desired Project Name (field cannot be blank).

2. Enter the desired short Project Description (field
cannot be blank).

3. Select the final time slice for Meta-Analysis

4. Complete the project settings by pressing the Create
Project button. This establishes the conditions for
the meta-analysis part of the workflow.

<— Back to quick start contents



3.21 Analysis lI-Running meta-analyses
on ocean climate modelling data

1.

.

GEMNERAL

Dashboards

APPLICATION

& Projects

My Brojects
Shared Projects

Madelling Data

GIS Layers

SUPPORT

FAQs

3 Suppoert Tickets

ﬂ Plymouth Marine Laboratory | | X 5

2% mspaceac.uk/f

Projects

Project List

View existing projects or create a new one.

3 Total Projects

Pu3 ERSEM EOE - Optimisation Pathway Test ERSEM EOE - Optimisation Pathway Test
P42 Worthem Ireland case study Northern ireland consarvation (benthic habitats)
P10 BOD_ERSEM_NL_Test BOD_ERSEM_NI_Test

Showing | to 3 of 3 projects.

Using the projects dashboard, press the

“Activities” button to initiate individual

meta-analyses setup within a project.

Search by Name or Code

13-10-2025 16:02.25

13-10-2025 15:25:10

13-10-2025 12.30:48

Benjamin

user

0/ MyProj

[ Activities Mview Outputs
M Activities Mview Outputs

iii
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3.21 Analysis [I-=Running meta-analyses
on ocean climate modelling data (continued)

0

GENERAL Projects Q) MyProject 3 | Scenar
Dashboards >
+ acd Actvity
APPLIGATION e
2 Projects v
e Rty T [ - |
My Projects

shared Projects

) Modelling Dats > =
PSta3 MSBACE (K] ERSEM 45 MSPACE (UK) ERSEM 45 Completed 13-40-2025 18:02.25 h optimisation | 00 view Output # Download HAQ

) GIS Layers >

Showing 1te 1 of 1 activities.

SUPPORT

FAQs

Support Tickets

Add Activity to The Project: P143

Select Scenario for the Activity:
@ — Select Scenario —

m

1. Press the “+ Add Activity” button

2. Use the dropdown menu to select the modelling data
of interest, which refers to a specific scenario of
interest (e.g. RCP 8.5)

3. Press the “Add Activity” button

<— Back to quick start contents
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3.21 Analysis [I-=Running meta-analyses
on ocean climate modelling data (continued)

0

y A\ £ = oo v Benjamin
FAL T g VYV uerw
GEMERAL Projgcts () / MyProject / Pi43 [ Scenarios
~) Dashboards >
Activity List
APPLICATION View existing project activities or create one

& Projects v

My Brojects

Shared Projects

Madelling Data > z
PSIBS MSPACE (UK) ERSEM 85 MSPACE (UK) ERSEM BS Not Started W-01-2026 % I optimisation 0 view Qutput

2} GIS Layers >
pEIAS MSPACE (UK) ERSEM 45 MSPAGE (UK) ERSEM 45 Complatad 130-2025 Eh optimisation | 0 View Output 4 Download HAD =
SUPPORT
Showing 1 to 2 of 2 activities.
& FAQs

T Support Tickets > n

Confirm Execution

Are you sure you want to execute this Activity?
Project: P143 - ERSEM EOE - Optimisation Pathway Test
Activity Code: PS165

Activity Name: MSPACE (UK) ERSEM B.5

Enter your password to confirm:

m o)

The target dataset for analysis will appearin
the Analysis dashboard

1. Press the “Execute” button to initiate the
meta-analysis.

2. Enteryour password
Press the “Execute” button

Completing the meta-analysis takes at least
30 minutes. You will receive an email when
this is complete. You can close the browser
and shut down your computer.

<— Back to quick start contents



3.22 Analysis IlI=Visualising
meta-analysis results

~ ﬂ Plymouth Marine Laboratory | | X 5

23 mspaceacu

o Benjamin
= oo User w
GEMERAL Projgcts ) ! MyProjects
Dashboards >

Project List

APPLICATION Yiew existing projects or

& Projects v
3 Total Projects

ch by Name or Code

My Brojects

Shared Projects

Madelling Data >
P15 ERSEM EDE - Dpti misation Pathway Test ERSEM EOE - Dptimisation Pathway Test 13-10-2025 18:02-25
GIS Layers >
pi42 Northern Ireland casa study Norther treland conservation (benthic habitats) 13-10-2025 15:26:10
SUPPORT
FAQS Pl0 BOD_ERSEM_NL_Test BOD_ERSEM_NI_Test 1310-2025 12:30:48 Act Mview Outputs —
i Support Tickets > Showing | to 3 of 3 projects.

1. Using the Projects Dashboard, press the
View Outputs button.
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3.22 Analysis IlI=Visualising

meta-analysis results (continued)

X o

s mspaceacuk/p

ACDAC 0 Benjamin
ASPACE & 0 ) ) A

S Project: P143 - ERSEM EQE - Optimisation @ ! Map [ Default
Pathway Test
() Dashboards >
APPLICATION F143 MSPACE (UK) ERSEM 45~ Summary M v | 2036-2055 "
& Projects v

My Brojects

Shared Projects

B Moadelling Data >

Great Britain

@ aiIs Layers >

SUPPORT Lancaster
Leeds|
Preston —
4 FAQs | ‘- WWaketield

& Manchester Sheffietd”
Ulyérpool
£33 Support Tickets > i e Lingoin

Stoke-or Notbingham

Derty

Lienfieta
g Liicostor o
Birmingham Paterbiorouah g
} rsterdam
Covantry. I
Ca Nederiand | - e
waoreéster r;;:O;: 3 Geldertarnd
v b
Haretard \ y Utdecht £oe
Giougester

Onfard St Albans

Reckingnal

Cardiff 3 lﬂr‘iélon
o Essen
[/ Bristol

- Fir Dusseld

: Cantarbu > o i \ g
Wi Salisbury Geny__AntwBrpen 5
Jwinchester 3 Bruxelles - £ [
o reb e e - . - . ]

Using the Dropdown menus above the map:

1. Select the dataset of interest

2. Select the output Statistics of interest (please refer
to the Meta-Analysis section of the user manual for
interpretation).

3. Select the future period of interest (compared
against the reference period in the meta-analysis)

4. Select the variable of interest (Choice dependent)

<— Back to quick start contents
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3.23 Analysis IV - Overlaying GIS layers of
interest onto meta-analysis results

outh Marine Laboratory x +

m [0 2% mspaceacuk/p

ACDANC Benjamin
ACDACC (58 N
AcrALc @ user w
GENERAL Project: P143 - ERSEM EQE - Optimisation "

@ / Map [ Defau
Pathway Test
() Dashboards >
APPLICATION P143 MSPACE (UK) ERSEM 4.5 v High Agreement v Combined v | Base Map | GIS Layer
5 +
My Projects :
Shared Projects
B Moadelling Data >
@ GlSs Layers > Great Britain
Ripop
SUPPORT
Lancastar
vérk
Leeds —
o Sl ¢ Wwaketield e
£3 Suppert Tickets > 5 4 v Shefficid
Liverpaol
Pz Chester (Y
Wiewnham Natbinaham
Darby]
L G e R e :
Lelystad
Coventry
Nederland fnuen
worcdster o r A Ge!
Hareford i k) £ - UII'E'I.'IK Ede
Gloucester et
Onfary S Albans
He Recklingnal
Cardiff Nplrr
3 < Essen
Bristol ~ -
¥ Dusseld
Waiis: Salisbury Antwarpen 2 % r I

The relationship between climate change sensitivity
and the distribution of species, habitats, marine
activity sectors and administrative borders

1. Follow the instructions given in Analysis IlI—
Visualising met-analysis results to bring up the
plots of interest

2. Press the “GIS layers” button

<— Back to quick start contents



ASPACE USER GUIDE QUICK-START GUIDE 48

3.23 Analysis IV - Overlaying GIS layers of
interest onto meta-analysis results (continued)

Select GIS Layers x

GIS Layer Category

GENERAL Project: P143 - ERSEM EQE - Optimisation @H -- Select Category - v

Pathway Test
() Dashboards >
APPLICATION P143 MSPACE (UK) ERSEM 4.5 v High Agresment ~ Combined
=i :
My Projects =
Shared Projects
B Moadelling Data >
@ aiIs Layers > Great Britain
Aipan
SUPPORT )
Landhstar
work
Leeds
& Fags Presion :
. Wakefield
3 Suppert Tickets > o Manchester Sheffieid
Liverpool
t Azaph
W L, Nothingham
Trent paviy|
Lien ol
o, Leicaster
B nlingham ) ae e Noriweh
Coventry_ ety
Cambridge
worcdster Milton
Harmtore Keynes
Gloucester |
Oxfard St Albans
Cardiff | London
Bristol
o Salisbury

1. Select the GIS layer Category for the
GIS layer of interest

<— Back to quick start contents
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3.23 Analysis IV - Overlaying GIS layers of
interest onto meta-analysis results (continued)

outh Marine Laboratory x +

m [0 2% mspaceacuk/p

ACDAC = Select GIS Layers x

GIS Layer Category
GENERAL Project: P143 - ERSEM EQE - Optimisation

UK planning areas (GCN9) v
Pathway Test
(x) Dashboards * GL143 - Welsh National Marine Plan
> . (O areas - welsh Government
APPLICATION P43 MSPACE (UK) ERSEM 4.5 v High Agresment ~ Combined |
GLI45 - Orkney Islands Regional Marine
_ 5 N onanisas
My Frajects B b O GLISS - Marine plan areas in England -
Shared Projects \ s L : ] MMO
Glasgow
(B M™odelling Data » e e United Kingdom
= GL142 - Seottish Marine Regions -
© 6lIs Layers > ( . [] marine Scottand
7
i {
A Qs S e
3 Support Tickets » o § 3
.

:

Jer sey A
R Paris

- '
Glernaey 8 tavre Gouen

el

por ekt “Rennes

1. Check the box for the GIS layer of interest

2. Note that you can change the colour of
the GIS layer by pressing on the Blue
Square next to the checkbox

<— Back to quick start contents



Generating and
Phase 3 scoring
alternative spatial

mManagement
scenarios

; —Creating ASMS




3.24 Creating ASMS

D8 Plymouth Marine Laboratary | | X

25 mspace.ac.uk/pre

- > oo
GENERAL Projects
Dashboards >
Project List
APPLICATION xisting projects o new or
& Projects v
3 Total Projects
My Projects
Shared Projects
Madelling Data »
Pus ERSEM EOE - Opti ion Pathway Test
GIS Layers >
142 Northern Ireland case study
SUPPORT
FAQs 0 BOD_ERSEM _NIL_Tesl
(3 Support Tickets ¥ Showing 1 to 3 of 3 projects.

1. Navigate to the Project where you
would like to create an ASMS
2. Press the “Activities” button

ERSEM EOE - Dptimisation Pathway Test

MNorthern Ireland consarvation (benthic habitats)

BOD_ERSEM_NI_Test

13-10-2025 16:02-25

13-10-2025 15:35:10

13-10-2025 12:30:48

Benjamin



3.24 Creating ASMS

~v DB Plymouth Marine Laboratory | | X

[0 % mspaceacuk/proj -enarios/

o Benjamin
% - o User w
GENERAL Projects G ! MyProject / P43
Dashboards >

Activity List

APPLICATION Kisting project activities or ¢reate one.

& Projects v
1 Total Activity Search by Name or Code

My Projects

Shared Projects

Madelling Data >
PS143 MSPACE {UK) ERSEM 45 MSPACE (UK) ERSEM 45 Completed 13-10-2025 160225 & optimisation 0 View Output

GIS Layers »
Showing | to 1 of 1 activities.
SUPPORT
FAQs
} Support Tickets » 1

1. Press the “Optimisation” button on the

Project Activity of choice



3.24 Creating ASMS

v BB Plymouth Marine Laboratory |1 X +

25 mspaceacuk/p

GENERAL iject
Dashboards >
Optimisation List
APPLICATION ject: P143 - ERSEM athw t
Activity: PS143 - MSP
& Projects v
3 Total Optimisations
My Projects
Shared Projects
Madelling Data »
2 GIS Layers >

sots2 Example Project Name Advanced

SUPPORT

soz1 BOD Version 21 Eok Advanced

& FAQs

T Support Tickets >

som BOD - Test ECE w1 Advanced

Showing 1 to 3 of 3 optimisations.

There are three methods to create ASMS from within the
Optimisation List tab.

In order to conduct Economic modelling and Social
scoring please follow the additional steps described
in Scoring ASMS using climate evidence, economic

modelling and alignment with social values

1. Create ASMS via the basic wizard:
Using the basic mode allows users to apply pre-

loaded defaults, for the constraints in their analysis.
These defaults have been set by the ASPACE

team and are applicable for a set of very specific
scenarios. Therefore, the basic mode provides

very limited benefit to the user and is suitable for
only a few case study sites. This method is not
recommended for most use cases.

Benjamin

iii

Completad

Benjamin

Completed
0

Comploted

2. Create ASMS via the advanced wizard:
Using advanced mode allows users to customise the

constraints in their analysis. Users can filter the GIS
layers based on the parameters within the data file.
This method is recommended for most users

3. Create ASMS via cloning
Users can clone existing ASMS. Users can then modify

the parameters of the ASMS with values that suit their
analysis. This facilitates rapid ASMS creation as it
allows the user to fine tune parameters quickly.



3.25 Create ASMS via the basic wizard

v BB Plymouth Marine Laboratory |1 %

(D % mspaceacuk/p

- o Benjamin

2 1 user w
GENERAL Project Q) ! MyProjects / P43 [ Scenarios / PS143 / Optimisations

Dashboards >
Optimisation List

Project: P143 - ERS

y: PS143

APPLICATION

& Projects v

3 Total Optimisations

My Projects

Shared Projects _ Compare Results 0 view Output

Madelling Data »

GIS Layers »

iii

sos2 Example Project Name Advanced co [ ] h clone
SUPPORT
Benjam ¥
soiz1 BOD Version 21 EoE Advanced Completed th clone
FAQs a2)
} Suppert Tickets > Benjamin
Suppaft Ticket som BOD - Test EGE v1 advanced Comploted ©h clone

Shawing 1 to 3 of 8 optimisations.

1. Press the “+ Add Optimisation” button
2. Press the “Basic Mode” button



3.25 Create ASMS via the basic wizard

v BB Plymouth Marine Laboratory | | X +

5 C M@

p 25 mspace.ac.uk/projects/70/scenarios/75/optimisations/basic/new/

Create optimisation

Fill in this form to configure and run an optimisation
GENERAL

Step-1
3 Scenario & activity
) Dashboards >
Optimisation scenario
APPLICATION
G Projects ¥ Planning Objective* 1
li Resili f A
Myiprajests Q Climate Resilience of Current Areas
Shatad|Rrclacks O New Areas to Increase Sectoral Climate Resilience
( Modelling Data > Select Planning Mode" 2 3
% O single sector
2 GIs Layers >
Q© Multiple Sector
BUERORY, Select Marine Sector”
N © Water Column (Pelagic)
\ FAQs
O seafloor (Benthic/Demersal)
£3 Support Tickets >

Increase in Sector Area (%) *

£g.10.

Coastal Distance (m)

eg. 5000

Copyright 2024 @ Plymouth Marine Laboratory.

Your options on the page will change depending on your
selections. The descriptions below cover all possible
options:

1. Select the planning objective

A. Climate Resilience of Current Areas

B. New Area to Increase Sectoral Climate Resilience
2. Select planning m,ode:

C. Single Sector:

D. Multi Sector: (Coming soon)

3. Enter Value for “Increase in Sector Area (%)

This gives the target percentage increase in provision for
your primary sector based available climate resilient areas.
This value is calculated after filtering on the GIS layer has
been conducted. A10% increase on a primary sector with

100 km? will attempt to increase the region by 10 km=2.

4. Enter Value for “Optimisation Tolerance (%)”:
This sets the flexibility in the final ASMS region
calculation. A lower optimisation tolerance will require
the optimisation pathway to work harder to find region

within the upper and lower bounds, this can cause

o Step-2

Step-3

Optimisation Tolerance (%) *

eg.10.

Depth (m)

Recommended range between O and 50 m.

Proceed to Next =

MSPACE / ASPACE

delays in the calculation and can even leave the ASMS
generation failing. Relaxing this value gives broader
region of values that are acceptable for the region to be. A
10% increase on a primary sector with 100 km?, with a 10%
optimisation tolerance will attempt to increase the region
by 10 km? but will settle on anything between 9 km?2< x <
1M km2. It is recommended to start with a value of 10%.

5. Enter Value for “Coastal Distance (m)™:

Some sectors require a maximum distance from the
coast to be considered for their analysis. Entering a value
in this input will constrain the ASMS output to areas that
are within this distance from the coastline. Leaving this
blank will include all regions regardless of the distance
from the coast.

6. Enter Value for “Depth (m)™:

Some sectors require a maximum depth to be considered
for their analysis. Entering a value in this input will
constrain the ASMS output to areas that are within

this depth. Leaving this blank will include all regions
regardless of the depth.

7. Press the “Proceed to next” button



3.25 Create ASMS via the basic wizard

DB Plymouth Marine Laboratory | 1 X +

23 mspace.ac.uk/projects/70/scenarios/75/optimisations/basic/new/

() Dashboards >
Create optimisation

APPLICATION Fill in this form to configure and run an optimisation.

Step-1
& Projects v e P

Myibrejests GIS Layer Selection

Shared Projects

(3 Modelling Data > N
1) Primary Sector (Mandatory) A

© als Layers >
Primary Sector (Mandatory)

SUPPORT Layer category"

N GC120 - Global MPA networks
/N FAQs

Filter mode

Inclusive O Exclusive 1l

Loaded from layer defaults / saved value; read-only.

3 support Tickets >

Default filters (read-only)

No default filters.

2) Additional Constraints (Optional)

Additional Layer(s)

€ Previous

The completion of Step 2 depends on which Planning

Objective has been selected.

1. Climate Resilience of Current Areas - The order in
which layers are selected is not considered for this
ASMS type.

A. In the “Primary Sector” card:

I. Select the “Layer Category” for your GIS layer of
choice

Il. Select the GIS layer from the “Layer” dropdown

[1l. You will notice that the “Filter Mode” and “Default
Filters” are set by defaults, these can not be
changed in this mode. If you wish to change
these please follow the instructions described in
the Create ASMS via the advanced wizard

B. Inthe “Additional Constraints” card:
I. If you require additional constraints for your
analysis, press the “Add layer”
Il. Repeat steps mentioned above for all of the

additional constraints required for your analysis.

[ll. When you have added all of the appropriate
constraints press the “Proceed to Next” button

Layer*

w GL147 - WDPA_WDOECM_Mar2024_Public_marine_shp-polygons v

C Proceed to Next =

2. New Area to Increase Sectoral Climate

Resilience - The order in which layers are selected is
considered for this ASMS type.

The “Primary Sector” card represents the sector

in which you would like to expand provision. In

the “Primary Sector” card:

I. Select the “Layer Category” for your GIS layer of
choice

IIl. Select the GIS layer from the “Layer” dropdown

[1l. You will notice that the “Filter Mode” and “Default
Filters” are set by defaults. These can not be
changed in this mode. If you wish to change
these please follow the instructions described in
the Create ASMS via the advanced wizard

In the “Additional Constraints” card:

I. If you require additional constraints for your
analysis, press the “Add layer”

Il. Repeat steps mentioned above for all of the
additional constraints required for your analysis.

When you have added all of the appropriate
constraints press the “Proceed to Next” button



3.25 Create ASMS via the basic wizard

™ ﬂ Plymouth Marine Laboratory || %X +

< C M [D 25 mspace.ac.uk/projects/70/scenarios/75/optimisations/basic/new/
) ao Benjamin
E13) User w
GENERAL
Create optimisation
() Dashboards > Fill in this form to configure and run an optimisation
Step-1 Step-2 Step-3
APPLICATION Name & description
2 Projects 7 Name & Description
My Projects
Shared Projects Name *
[ Modelling Data > Climate resilient MPA networks in the East of England 1
e.g. XYZ - Multiple Sector Pelagic.
GIS Layers >
Description "
SUPPORT This ASMS scenario determines areas of MPA, filtered for species associated with sea-grass habitats that are climate resilient.
[\ FAQs
{1 Support Tickets > %
Briefly describe the objectives and any key constraints.

€ Previous

1. Complete the “Name” input
2. Complete the “Description” input
3. Press the “Save Configuration” button
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3.25 Create ASMS via the basic wizard

(continued)

v D8 Plymouth Marine Laboratory |

oo Benjamin
oo User w
GENERAL iject [ ! MyProjects / PI43 [ Scenarios / PS143 / Optimisations
7 Dashboards >

Optimisation 50270 created.
APPLICATION

@ Projects - Optimisation List
Project: P143 - ERSEM EOE - Optimisation Pa y Tast
= Activity: PS143 - MSPACE (UK) ERSEM 4.5
My Projects
Shared Projects ey n .
4 Total Optimisations Search by Opt Code/Name, Project Code/Name, Activity Code Clear

) Madelling Data >

) GIS Layers » + Add Optimisation ~ Compare Results

SUPPORT

Benjamin = —
s0270 Climate resilient MPA networks in the £a Basic % Not Started % 4 clone =
FAQsS n5-0renes
{3 Support Tickets > Benjamin
P sois2 Example Project Name Advanced Completed Yy i clone 4 Download
& clone 4. Dawnload -
Benjamin
soim BOD - Tost EGE ¥1 Advanced Completad i & el 4 oownload
(10200

Showing | to 4 of 4 optimisations.

1]

smz1 BOD Version 21 E0E Advanced Completed

1. Your ASMS will appear at the top of the
table with a status of “Not Started”
2. Press the “Execute” button

<— Back to quick start contents
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3.25 Create ASMS via the basic wizard

(continued)

DB Plymouth Marine Laboratory

Execute Optimisation

Project: P143 - ERSEM EOE - Optimisation Pathway Test

Activity: PS143 - MSPACE (UK) ERSEM 4.5

Optimisation: SO270 - Climate resilient MPA networks in the East
af England

Enter your password to confirm:

i

1. Enter your password
2. Press the “Execute” button

Completing the ASMS generation takes at least

10 minutes. You will receive an email when this is
complete. You can close the browser and shut down
your computer.

<— Back to quick start contents



3.26 Create ASMS via the advanced wizard

v BB Plymouth Marine Laboratory |1 %

(D % mspaceacuk/p

- gﬁ Benjamin
1 Uiacie

GENERAL Project .

Dashboards >
Optimisation List
APPLICATION Project: P183 - ERSEM EC AUAW 1
PS143 - M

& Projects v

3 Total Optimisations

My Projects

_
Madelling Data y

I ey |
GIS Layers »
soisa Example Project Name Advanced o [ Advanced Mode } =
SUPPORT
Benjamin e
soii BOD Version 21 EoE Advanced Completed 4 I cClone i A =
A FAQs (b s stany L
o o Benjamin = =

Showing | to 3 of 3 eptimisations.

1. Press the “+ Add Optimisation” button
2. Press the “Advanced Mode” button



3.26 Create ASMS via the advanced wizard

N ﬁ Plymouth Marine Laboratory | x +

- C @ P

25 mspace.ac.uk/projects/70/scenarios/75/optimisations/basic/new/

Create optimisation
Fill in this form to configure and run an optimisation.

Step-1

Scenario & activity

GENERAL

() Dashboards >

Optimisation scenario
APPLICATION

(3 i v
Projects Planning Objective* 1

3 O climate Resilience of Current Areas
My Projects

Shared Projects (O New Areas to Increase Sectoral Climate Resilience

Select Planning Mode® 2 3

) Modelling Data >

x O Single Sector
@ Gls Layers >
QO Multiple Sector

SUPPORT Select Marine Sector”

© Water Column (Pelagic)
£ FAQs
O seafloor (Benthic/Demersal)

£3 support Tickets >
Increase in Sector Area (%) *

eg.10.

Coastal Distance (m)

.8, 5000

Your options on the page will change depending on your
selections. The descriptions below cover all possible

options:

1. Select the planning objective

A. Climate Resilience of Current Areas

B. New Area to Increase Sectoral Climate Resilience
2. Select Planning Mode:

C. Single Sector:

D. Multi Sector: (Coming soon)

3. Enter Value for “Increase in Sector Area (%)™

This gives the target percentage increase in provision
for your primary sector based available climate
resilient areas. This value is calculated after filtering
on the GIS layer has been conducted. A 10% increase on
a primary sector with 100 km?2 will attempt to increase
the region by 10 kma.

4. Enter Value for “Optimisation Tolerance (%)
This sets the flexibility in the final ASMS region
calculation. A lower optimisation tolerance will require
the optimisation pathway to work harder to find region

within the upper and lower bounds, this can cause

° Step-2

Step-3

Optimisation Tolerance (%) *

eg.10.

Depth (m)

Recommended range between 0 and 50 m.

Proceed to Next

delays in the calculation and can even leave the ASMS
generation failing. Relaxing this value gives broader
region of values that are acceptable for the region

to be. A10% increase on a primary sector with 100

km?, with a 10% optimisation tolerance will attempt

to increase the region by 10 km?2 but will settle on
anything between 9 km2< x < 11 kma. It is recommended
to start with a value of 10%.

5. Enter Value for “Coastal Distance (m)™:

Some sectors require a maximum distance from the
coast to be considered for their analysis. Entering a
value in this input will constrain the ASMS output to
areas that are within this distance from the coastline.
Leaving this blank will include all regions regardless of
the distance from the coast.

6. Enter Value for “Depth (m)”:

Some sectors require a maximum depth to be
considered for their analysis. Entering a value in this
input will constrain the ASMS output to areas that are
within this depth. Leaving this blank will include all
regions regardless of the depth.

7. Press the “Proceed to next” button
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3.26 Create ASMS via the advanced wizard

(continued)

62

= ) Step-1 o Step-2 Step-3
&) Projects & Scenario & activity Name & description
My Project. .
l HEEtelschy GIS Layer Selection N\
Shared P t
LIRS Configure the primary sector and any additional conste{ A )= 1
[ Modelling pata ) U
1) Primary Sector (Mandatory)
© als Layers >
Primary Sector *
L t " Layer *
suppoRT ayer category ayer
GC120 - Global MPA networks v GL147 - WDPA_WDOECM_Mar2024_Public_marine_shp-polygons )
/N FAQs
£3 support Tickets > Elltennece

O Inclusive © Exclusive

Quick action
O select all as filter

Saves colunn_to_filter: “all" and keywords_to_filter: ["all"]

Column

DESIG_TYPE

Column Filter Name

e.g. Priority filter

H[ + Add column filter ][ O clearall ]

Active filters

2) Additional Layers

Additional Layer(s)

The completion of Step 2 depends on which Planning
Objective has been selected.

1. Climate Resilience of Current Areas - The order
in which layers are selected is not considered
for this ASMS type.

A. In the “Primary Sector” card:

I. Select the “Layer Category” for your GIS layer of
choice

Il. Select the GIS layer from the “Layer” dropdown

[ll. Select the Filter Mode for your GIS layer:

a. If a GIS layer is set to “Inclusive” then the
ASMS calculation will analyse areas where the
layer overlaps with climate resilient areas.

b. If a GIS layer is set to “Exclusive” then the
ASMS calculation will subtract this layer
away from any climate resilient areas. This is
used when the user is aware of the influence
of existing areas which must be catered for
in their analysis.

. Filter the GIS layer. The user has the option to

subset the GIS layer for their specific analysis:

<— Back to quick start contents

63)
N/

Values

International
National

Not Applicable
Regional

OO <O

<

Notes

Optional notes

W Remove column

(8)—>
(c)—

a. If the user would like to include all of the

Proceed to Next

regions in their analysis press the “Select all
as filter” button
b. If the user would like to subset the region:

i. Firstly, select the column to filter on by
using the “Column” dropdown.

ii. Secondly, multi-select the values to filter
against from the “Values” input. Note that
for larger GIS layers it can take up to one
minute for all of the values to appear on
the screen.

iii. If the user requires multiple filters then

repeat the above two steps after pressing
the “+ Add Column Filter” button

B. Inthe “Additional Constraints” card:
I. If you require additional constraints for your
analysis, press the “Add layer”
Il. Repeat steps mentioned above for all of the
additional constraints required for your analysis.

C. When you have added all of the appropriate
constraints press the “Proceed to Next” button

Continued overleaf —>
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3.26 Create ASMS via the advanced wizard

(continued)

= ) Step-1 o Step-2 Step-3
(@ Projects 2 Scenario & activity Name & description

l My Projects

GIS Layer Selection m
Shared P t
LIRS Configure the primary sector and any additional conste{ A )= 1
[ Modelling Data > ‘ U
1) Primary Sector (Mandatory)
© als Layers >
Primary Sector *
L t " Layer *
SUPPORT ayer category ayer
GC120 - Global MPA networks v GL147 - WDPA_WDOECM_Mar2024_Public_marine_shp-polygons )
/N FAQs
£3 support Tickets > Elltennece

O Inclusive © Exclusive

Quick action
O select all as filter

63)
N/

Values

Saves colunn_to_filter: “all" and keywords_to_filter: ["all"]

International
National

Not Applicable
Regional

OO <O

Column

DESIG_TYPE

<

Column Filter Name Notes

e.g. Priority filter Optional notes

H[ + Add column filter ][ O clearall ]

Active filters

W Remove column

2) Additional Layers

SR Cayare) H

2. New Area to Increase Sectoral Climate a. If the user would like to include all of the
Resilience - The order in which layers are regions in their analysis press the “Select all
selected is considered for this ASMS type. as filter” button

b. If the user would like to subset the region:
A.  The “Primary Sector” card represents the sector i. Firstly, select the column to filter on by
in which you would like to expand provision. In using the “Column” dropdown.
the “Primary Sector” card: ii. Secondly, multi-select the values to filter
I. Select the “Layer Category” for your GIS layer of against from the “Values” input. Note that
choice for larger GIS layers it can take up to one
Il. Select the GIS layer from the “Layer” dropdown minute for all of the values to appear on
[ll. Select the Filter Mode for your GIS layer. the screen.

a. If aGIS layer is set to “Inclusive” then the iii. If the user requires multiple filters then
ASMS calculation will analyse areas where repeat the above two steps after pressing
the layer overlaps with climate resilient the “+ Add Column Filter” button
areas.

b. If a GIS layer is set to “Exclusive” then the B. Inthe “Additional Constraints” card:

ASMS calculation will subtract this layer I. If you require additional constraints for your
away from any climate resilient areas. This is analysis, press the “Add layer”
used when the user is aware of the influence Il. Repeat steps mentioned in above for all of the
of existing areas which must be catered for additional constraints required for your analysis.
in their analysis.
IV. Filter the GIS layer. The user has the option to C. When you have added all of the appropriate
subset the GIS layer for their specific analysis. constraints press the “Proceed to Next” button

<— Back to quick start contents



3.26 Create ASMS via the advanced wizard

ﬂ Plymouth Marine Laboratory | | X et

C m

1]

-0

25 mspace.ac.uk/projects/70/scenarios/75/optimisations/basic/new/

GENERAL

Dashboards

APPLICATION

& Projects

My Projects

Shared Projects

Modelling Data

GIS Layers

SUPPORT

FAQs

"3 Support Tickets

Create optimisation

Fill in this form to configure and run an optimisation

e Step-1

Name & Description

Name *
Climate resilient MPA networks in the East of England
8. XYZ - Multiple Sector Pelagic.

Description *

This ASMS scenario determines areas of MPA, filtered for species associated with sea-grass habitats that are climate resilient.

Briefly describe the objectives and any key constraints.

Previous

Copyright 2024 © Plymouth Marine Laboratory.

1. Complete the “Name” input
2. Complete the “Description” input
3. Press the “Save Configuration” button

a Step-2

Benjamin

User w

Step-3

Name & description

MSPACE / ASPACE
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3.26 Create ASMS via the advanced wizard

(continued)

v B8 Plymouth Marine Laboratory |+ X

GENERAL iject [ ! MyProjects / PI43 [ Scenarios / PS143 / Optimisations
7 Dashboards >
APPLICATION
@ Projects N Optimisation List
Pro, P143 - ERSEM EOE - Optimisation Pathway Test

Activity: PS143 - MS

a ACE (UK) ERSEM 4.5
My Projects

Shared Projects i
4 Total Optimisation

o

Search by Opt

=N
Y Madelling Data »
615 Layers > + add optimisation = S s e aalie

SUPPORT

Benjamin =
soz70 Climate resilient MPA networks in the £a_ Besic % Not Started % i clone
FAQsS n5-0renes
{3 Support Tickets > Benjamin
P sois2 Example Project Name Advanced Comploted i & Clone 4 dawnlosd
1io 2648
Benjamin =
soi21 BOD Version 21 EoE Advanced Completed y B clone 4 pownload
Benjomin
soim BOD - Tost EGE ¥1 Advonced Completad 1 & clone 4 oownload
(14-10-2005

Showing | to 4 of 4 optimisations.

jii

1. Your ASMS will appear at the top of the
table with a status of “Not Started”
2. Press the “Execute” button

<— Back to quick start contents
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3.26 Create ASMS via the advanced wizard

(continued)

DB Plymouth Marine Laboratory

Execute Optimisation

Project: P143 - ERSEM EOE - Optimisation Pathway Test

Activity: PS143 - MSPACE (UK) ERSEM 4.5

Optimisation: SO270 - Climate resilient MPA networks in the East
af England

Enter your password to confirm:

i

1. Enter your password
2. Press the “Execute” button

Completing the ASMS generation takes at
least 10 minutes. You will receive an email
when this is complete. You can close the
browser and shut down your computer.

<— Back to quick start contents



3.27 Create ASMS via cloning

* Plymouth Marine Laboratary | x +

2% mspace.ac.uk

0o Benjamin

user w

GENERAL Projgct R /! MyPrajects / PI43 [ Scenarios

Dashboards >

Optimisation List
Project: P143 - ERSEM EOE

APPLICATION

Activity: PS143 - MSPACE (U

& Projects ¥
3 Total Optimisations

1 by Opt Code/Na

My Brojects

Madelling Data »
GIS Layers b3
Benjamin =
sois2 Exampls Project Name Advanced Completad ==
0-202
SUPPORT
Benjamin o
sonzi BOD Version 21 £ok advanced Completed =
FAQsS

som BOD - Test ECE v Advanced Completed

3 Suppert Tickets > Benjamin
110202

Showing 1 to 3 of 3 optimisations.

1. Press the “Clone” button on the ASMS
of choice
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3.27 Create ASMS via cloning (continued)

DB Plymouth Marine Laboratory

Clone Optimisation

Source: SO182 - Example Project Name

Project: P143 - ERSEM EOE - Optimisation Pathway Test
Activity: PS143 - MSPACE (UK) ERSEM 4.5
New Name *
Example Project Name (copy)
New Description

Example Project Description

1. Cloning a project will launch a dialogue box
with a default “Name” and “Description” added.
Change the contents of these entries.

2. Press the “Create Clone” button.

<— Back to quick start contents

68
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3.27 Create ASMS via cloning (continued)

v B8 Plymouth Marine Laboratory |+ X

C m [p 23 mspace.ac.uk/projects/70/scenarios/75/optimisations/

GENERAL iject [ ! MyProjects / PI43 [ Scenarios / PS143 / Optimisations
%) Dashboards >

Optimisation cloned as 50270,
APPLICATION

Optimisation List
Projact: P14 - ERSEM EOE - Optim

& Projects v

tion Pathway Tast

a Activity: PS143 « MSPACE (UK) ERSEM 4.5
My Projects

Shared Projects

4 Total Optimisations Search by Opt Code/Name, Project Code/Name, Activity

=n
Y Madelling Data >
ElljctsiLeyalx 2 ol L

SUPPORT

Benjamin o
80270 Example Project Name (copy) Advanced Mot Started L Clene %
&y FAQs (15012026 18:47
(3 Support Tickets > Benjamin
P sois2 Example Project Name Advanced Completed Y N Glone 4 pownload
(17102025 15:01)
genjamin —
soz1 BOD Version 2] EoE Advanced Completea S 4 pownload
Benjomin
soim BOD - Tost EGE v1 dvanced Comploted L & clone 4 oewnload
(14-10-2025 0818)

Showing | to 4 of 4 optimisations.

jii

1. The cloned ASMS will appear in the top row of the table

2. To change the ASMS configuration, press the Burger
Menu icon

3. Then press the “Edit” icon

4. Edit the contents of ASMS configuration by following
the instructions for Basic and Advanced modes

respectively

<— Back to quick start contents
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3.27 Create ASMS via cloning (continued)

v D8 Plymouth Marine Laboratory |

oo Benjamin
oo User w
GENERAL iject [ ! MyProjects / PI43 [ Scenarios / PS143 / Optimisations
7 Dashboards >
Optimisation 50270 created.
APPLICATION
@ Projects N Optimisation List
Project: P143 - ERSEM EOE - Optimisation Pa y Tast
= Activity: PS143 - MSPACE (UK) ERSEM 4.5
My Projects
Shared Projects PN =
4 Total Optimisations Search by Opt Code/Name, Project Code/Name, Activity Code Clear
) Madelling Data »

) GIS Layers » + Add Optimisation ~ Compare Results

SUPPORT

Benjamin = —
s0270 Climate resilient MPA networks in the £a Basic % Not Started % 4 clone =
FAQsS n5-0renes
{3 Support Tickets > Benjamin
P sois2 Example Project Name Advanced Completed Yy i clone 4 Download
& clone 4. Dawnload -
Benjamin
soim BOD - Tost EGE ¥1 Advanced Completad i & el 4 oownload
(10200

Showing | to 4 of 4 optimisations.

1]

smz1 BOD Version 21 E0E Advanced Completed

1. Your ASMS will appear at the top of the
table with a status of “Not Started”
2. Press the “Execute” button

<— Back to quick start contents
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3.27 Create ASMS via cloning (continued)

DB Plymouth Marine Laboratory

Execute Optimisation

Project: P143 - ERSEM EOE - Optimisation Pathway Test

Activity: PS143 - MSPACE (UK) ERSEM 4.5

Optimisation: SO270 - Climate resilient MPA networks in the East
af England

Enter your password to confirm:

i

1. Enter your password
2. Press the “Execute” button

Completing the ASMS generation takes at
least 10 minutes. You will receive an email
when this is complete. You can close the
browser and shut down your computer.

<— Back to quick start contents



3.28 Scoring ASMS using climate
evidence, economic modelling and
alignment with social values

v 98 plymouth Marine Laboratory |1 X +

2% mspace.ac.uk/projects/69/scenarios/74/optimisations/advanced/new/

GENERAL Step-1
Scenario & activity
Dashboards >
GIS Layer Selection
APPLICATION t
B projects = 1) Primary Sector (Mandatory)

o Primary Sector *
My Projects

Layer category *
Shared Projects
o Select a category...
@ Modelling Data »
GIS Layers > Filter mode
Q inclusive (O Exclusive
SUPPORT
Quick action
FAQs [0 select all as filter
Saves colum_to_fllter: “all” and keyworos_to_filter: [“al1"]
Support Tickets >
+ add column filter O clear s

Active filters

2) Additional Layers

Additional Layer(s)

The ASPACE platform can estimate economic modelling
and social values scoring of ASMS to enhance the
decision support capabilities to the user( please see
section 4). These features are only currently available for
UK regions, with other areas currently in development
for future releases. At present, these features are
specifically available at the UK level, and also at nation
and regional level as follows:

+ United Kingdom Exclusive Economic Zone (EEZ)
+ Orkney Islands Marine Plan (Scotland)

+ East of Marine Plan (England)

« Welsh National Marine Plan

+ Marine Plan for Northern Ireland

Benjamin
ser w

Step-3

Name & dascription

Layer *

W Select a layer... v

In order for the ASPACE to provide these estimates for
individual ASMS (created using Optimisation option 2),
the user must select one of the appropriate GIS layer
when conducting ASMS generation, which enables the
ASPACE tool to select the correct economic model and
social values matrix for the region of interest, according
to those listed above.

1. Inthe ASMS creation wizard, add an additional
layer by pressing the “+ Add layer” button within the
“Additional Layers” card.



3.28 Scoring ASMS using climate
evidence, economic modelling and
alignment with social values

v B8 Plymouth Marine Laboratory |1 X +

Cc @ [P 25 mspace.ac.uk/projects/70/scenarios/75/optimisations/advanced/new/

o Benjamin
user w

<) AUUILIDNA] Layers

GENERAL 1 2
Additional Layer(s) 4 Add layer
Dashboards > \
Additional Layer 1 @ Rer
APPLICATION Layer category Layer
2 5 GCNY - UK planning areas v GL159 - Northern Ireland marine plan area - UKHO (amended to polygon, see descrij v
rojects v
Layer name (label) Layer notes
My Projects
Ehia Bl Additienal Layer1 Optional notes
@ madelling Data > Fira
7) GIS Layers » Q Inclusive (O Exclusive
S Quick action
Y [ select all as filter
A FAQs Saves column_to_fllter: =all”and keywords_te_fllter: ["all"l.
1 Support Tickets b
Values
Column
Select a column... v
Column Filter Name Notes
e.g- Priority filter Optional notes
Case Study Site Layer Category  Layer Category Layer Layer Description
Code Description Code
Orkney Islands GC119 UK planning areas GL145 Orkney Islands Regional Marine plan
Wales GC119 UK planning areas GL143  Welsh National Marine plan areas
East of England GC119 UK planning areas GL155 Marine plan areas in England
Northern Ireland GC119 UK planning areas GL159  Northern Ireland marine plan area
United Kingdom EEZ  GC122 Maritime limits and GL156  United Kingdom EEZ

boundaries

1. Select the “Layer category” and “Layer” shown in the 3. The user is still able to subset this GIS layer in the
table above. This selects the economic model and same way as mentioned in the ASMS advanced

social values matrix for the region of interest for the wizard.

user defined when they created their current Project.
2. In the screenshot above the user has selected the
“Layer Category” and “Layer” associated with the

Northern Ireland marine plan area.
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Visualising,
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downloading
alternative spatial
mManagement
scenarios

—Visualising ASMS
—Comparing ASMS




3.29 Visualising from the ASMS
activity overview page

o ﬂ Plymouth Marine La tory | X x

25 mspace.ac.uk

o Benjamin
- user v
GENERAL Projects BN g i
Dashboards >
Activity List
APPLICATION View existing project activities or create one.
& Projects v
1Total Activity Search by Name or Code

My Projects

Shared Projects

Madelling Data ¥ = =
PSI43 MSPACE {UK) ERSEM 4.5 MSBACE (UK) ERSEM 45 Completed 1310-2025 16:02:25 & optimisation | T0view Output | Hicompare

GIS Layers b

iii

Showing | to 1 of 1 activities.

SUPPORT

FAQs g 2

3 Support Tickets >

1. Navigate to the “Activity List” page of the
Project of interest

2. Press the “View Outputs” button on the Activity
containing the ASMS of interest
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3.29 Visualising from the ASMS
activity overview page (continued)

v

NCDAC 00 & Benjamin
A FALC o0 @ ¢ User w
GEMERAL Shared prnject () / Shared Project / P157 / Scenarios / PSIS8 / Optimisations
() Dashboards >
Optimisation List
APPLICATION Project: P157 - Orkney_BenHabs_test  Global
Activity: PS158 - MSPACE (UK) ERSEM 4.5
& Projects v

1 Total Optimisations Search by Opt C

e/Name, Project Code/Name, Activity Code -
My Projects
Shared Projects

™ madelling Data »
GIS Layers ¥
sozan vy WP incrsase 0% 1 advancea Completea Uiz (3or2nerze
SUPPORT

Benjamin ] —
FAQs s0260 BOD Type 2 - Sacondary Method Advanced Completed ) 4 pawnlosa =
& E 302026 14:26)
£33 Support Tickets > —
s0253 Orkney BenHabs existing climate resilien. Advanced Completed Lz (13012026 Mad) ] e 'S Download
Benjamin - 2
soes2 BOD - Stress Test 2 Advanced Completed 4 pownload
3-01-2028 14:4)
50250 Orkney BenHabs existing climate resilisn_. Advanced Completed Lz (13-0t-2026 1413 4 pownload
Benjamin =
a-0-2028 1

Benjamin = -

iii

®

1. Navigate to the “Optimisation List” page on the
Project Activity of interest

2. Press the “View Outputs” button on the top of the
ASMS table list

<— Back to quick start contents



3.29 Visualising from the ASMS
activity overview page

v BB Plymouth Marine Laboratary || X +

23 mspace.ac uk/proj

Benjamin
User w

GENERAL View Qutput 1 3 () / Shan roject isat
Dashboards >
Activity: MSPACE (UK) ERSEM 4.5
APPLICATION Use this page Lo view and perform further analysis on the output.
P57 PS1S8 Optimisation ~  SD261-Orkney M w ASMS Region v | Basemap
& Projects - '
My Projects

Shared Projects

Madelling Data »

GIS Layers >
SUPPORT

FAQs

Support Tickets >

Using the Dropdown menus above the map:

1. Select the “Optimisation” option from the “Select
Statistics” dropdown

2. Select the “ASMS Name” from the “Select
Optimisation” dropdown

3. Select the output of interest:

A.  ASMS Region:
I. For Climate resilience of current areas scenarios

this shows the region(s) which intersect all of B.

the user provided GIS layers with areas that are
predicted to be climate resilient.

Il. For New areas to increase sectorial climate

resilience scenarios this shows the new areas
that could be used to increase the climate
resilience of the primary sector, based on user
provided GIS layers.

[ll. The user can overlay any GIS layers in the
system to this map using the GIS layers button
on the top right corner, as done when visualising

the outputs of meta-analysis.

Refugia / Hotspots / Brightspots

l. Regions of Refugia / Hotspots / Brightspots,
useful in providing the user with wider context
on how the ASMS region(s) was calculated.
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3.30 Downloading the data

v

25 mspace.ac.uk/shared-projec enaric optimisations/

A CSNOIA N o0 47N, senjamin
WAL C o0 VYV uerw

GENERAL Shared projgct () / Shared Project { PI57 / Scenarios / PSIS8 / Dptimisations

Dashboards >
Optimisation List

APPLICATION Project

P187 - Grkney_BenHabs

Activity: PS158 - MSPACE (UK) ER

& Projects ™

1 Total Optimisations Search by Opt G

My Projects

-
Shared Projects
+ add Optimisstion = Compare Results
@ madelling Data >

GIS Layers. >

50261 Orknesy MPA increase 10% i Advanced Completed Lz (3-0ran261426) h clone 4 pownlosd %
SUPPORT
Benjamin —
A FAQs 30260 80D Type 2 - Secondary Method Advanced Completed Eh clone 4 pownlosd =
& s 2012028 1428)
(3 Support Tickets >
s0253 Orkney BenHabs existing climate resilien- Advanced Completed Liz (13012026 M34) th e 4 pownload
h clone 4 pownload =
50250 Orknay BenHabs existing climate resilisn_. Advanced Completed Uz (13-0+-2026 142 & pownload
Benjamin - "
so2ar 0D - Stress Tast Advencad Completed L 4 pownload
302028 1412)
Benjamin : .

soesz BOD - Stress Test 2 Advanced Completed

@

1. Navigate to the “Optimisation List” page on the
Project Activity of interest
2. Press the “Download” button on the ASMS of interest

<— Back to quick start contents
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3.31 Comparing ASMS

v B8 Plymouth Marine Laboratory |1 X +

25 mspace.ac.uk/shared-projec ena ptimisations/

Benjamin

user w

GENERAL Shared Project () / Shared Project / P157|/ Scenarios / PS158 / Optimisations

Dashboards >
Optimisation List

APPLICATION Project: P157 - Orkney_BenHabs Global

ty: PS158 - MSP

E (UK) ERSEM 4.5

& Projects ™

11 Total Optimisations Search by OF
My Projects

Shared Projects
+ acd optimisation = Compare Results
@ madelling Data >

GIS Layers >
soeel Orkney MPA incraase 10% v Advanced Completed Liz (3-01-20261426)
SUPPORT
FAQs $0260 BOD Type 2+ Secondary Method Advanced Completed =
{3 Support Tickets b
s0253 Orkney BenHabs existing climate resilien_. Advanced Completed Liz 03-01-2026 Had)
Benjamin - —
so2s2 80D - Stress Test 2 advanced Completed Eh clone 4 Downlosd =
i

s0250 Orknay BenHabs existing climate resilisn_. Advanced Completed Lz (13-0+-2026 142 4 pownload
Benjamin m S
so2ar 0D - Stress Tast Advencad Completed 5 4 pownload
-2028 1412)
Benjamin " n

1. Navigate to the “Optimisation List” page
on the Project Activity of interest

2. Press the “Compare Results” button on
the top of the ASMS table list

<— Back to quick start contents
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v OB Assisted Spatial Prioritisation X -

[D 2% mspace.ac.uk/shared-projects/93/scenarios/101/optimisations/compare/

o Benjamin
oo User @

GENERAL Compare Optimisation ( / Shared Project / PI64 nari S0 t "

Dashboards >

Project: P164 - Benthic habitats in the Irish Sea
APPLIGATION Activity: PS165 - MSPACE (UK) ERSEM 4.5
@ projects v 2 Total Processed
My Projects
? selected

Shared Projects & SalectAll

Modelling Data >

GiSayers . Expanding NI MPA by 30% into e

s0272 benthic refugia avoiding new Multiple Sector Advanced
wind leases
SUPPORT
. = s B Ana Queiros
o so2n Test Irish Sea Existing Climate Resilience Basic SRR
s N 2026-01-16 10:26
Support Tickets > ]
Compare Selected

ADMINISTRATION

User

Project 1 2

Model

GIS Layers

1. Use the check boxes on the left hand side to select the
ASMS of interest

2. Press the “Compare Selected” button
Scroll to the bottom of the page to see the comparisons
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-

mspace.ac.uk/shared-projects/93/scenarios/101/optimisa

ons/compare/

* Assisted Spatial Prioritisation
C m M@ =
8o
GENERAL
Dashboards >
APPLICATION
%4 Projects v
My Projects
Shared Projects
Modelling Data >
GIS Layers >
SUPPORT
FAQs
Support Tickets >

ADMINISTRATION

User

Project

General
ASMS Type
Case Study Site
Climate
Desired (%)
Tolerance (%)

Within tolerance bounds?

Optimised (%)

Optimised additional (km?)
Required additional (km?)
Lower limit (km?)

Upper limit (km?)

Greenhouse Gas Emissions - ASMS

(Thousands of Tonnes)

Economic
Gross Value Added - ASMS (EM)
Gross Value Added - BAU (EM)
Gross Value Added - Change (EM)
Labour Compensation - ASMS (EM)

Labour Compensation - BAU (EM)

Labour Compensation - Change (EM)

Number of People Employed - ASMS

Number of People Employed - BAU

Number of People Employed - Change

Social

Social Scoring - ASMS

Social Scoring - BAU

The table overleaf describes every

parameter within the comparison table.

Expanding NI MPA by 30% into benthic refugia avoiding
new wind leases

multiple_sector

uk_case_study

30

0.52%

2232.587026592991

127760.90653365015

125205.68840297715

130316.12466432316

990.0

1300.0

1400.0

100.0

760.0

780.0

200

22000.0

23000.0

1000.0

0.091

Benjamin

User @

Test Irish Sea

existing_climate_resilience

uk_case_study

1000.0

1400.0

1400.0

0.0

7700

780.0

10.0

22000.0

23000.0

1000.0

N/A

N/A
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3.31 Comparing ASMS (continued)

Name Description

ASMS Type Type of Alternative Spatial Management Scenario being evaluated

Case Study Site Geographic area or site used as the case study for this analysis

Desired (%) Target percentage of area to be optimised under the scenario

Tolerance (%) Allowed percentage deviation from the optimisation target

Within tolerance bounds? Indicates whether the optimisation result falls within allowed
tolerance

Optimised (%) Percentage of area optimised relative to the target

Optimised additional (km?2) Additional area successfully optimised by the scenario

Required additional (km?2) Total additional area required to achieve the optimisation goal

Lower limit (km?) Minimum additional area required to meet the optimisation target.

Upper limit (km?) Maximum additional area allowed within tolerance limits

Greenhouse Gas Emissions - ASMS Estimated greenhouse gas emissions under the ASMS scenario

(Thousands of Tonnes)

Greenhouse Gas Emissions - BAU Estimated greenhouse gas emissions under the Business-as-Usual
(Thousands of Tonnes) scenario
Greenhouse Gas Emissions - Change Difference in greenhouse gas emissions between ASMS and BAU

(Thousands of Tonnes)

Gross Value Added - ASMS (£M) Economic value generated under the ASMS scenario.

Gross Value Added - BAU (EM) Economic value generated under the Business-as-Usual scenario
Gross Value Added - Change (EM) Change in economic value between ASMS and BAU

Labour Compensation - ASMS (£M) Total labour compensation under the ASMS scenario

Labour Compensation - BAU (£M) Total labour compensation under the Business-as-Usual scenario
Labour Compensation - Change (EM) Change in labour compensation between ASMS and BAU

Number of People Employed - ASMS Number of people employed under the ASMS scenario

Number of People Employed - BAU Number of people employed under the Business-as-Usual scenario
Number of People Employed - Change Change in employment between ASMS and BAU

Social Scoring - ASMS Overall social impact score under the ASMS scenario

Social Scoring - BAU Overall social impact score under the Business-as-Usual scenario

<— Back to quick start contents



Core features
and functions

ASPACE is a transdisciplinary decision-support tool, for those exploring and
making decisions about marine space that address the effects of climate
change. The user can assess the current climate effects within a region of
interest and compare this with alternative spatial management scenarios
of their region of interest, based on climate change resilience, economic and
social value metrics.

The sections below outline, for each ASPACE feature, what it does, what
is its scientific rationale, guidance for best use and interpretation, and
current limitations.

In ASPACE, ocean climate modelling dataset analysis the first step of the
workflow. The aim is to classify waters in the region of interest based on their
estimated sensitivity to climate change. This analysis defines a Project: it is
the first part of the ASPACE workflow available for any new Project ( executed

by user command in the project Activities dashboard). The outputs of one
analysis within one project can then be used to create and compare alternative
spatial management scenarios (see Section 4.2).

Analyses of ocean climate modelling data in ASPACE are configured by the user to
target specific ecosystem components or marine sectors (e.g. benthic habitats;
pelagic fisheries; etc). That choice determines which modelling datasets are
selected for analysis by the user. One analysis may therefore yield different
outputs from another, for the same region, depending on their specific design.

Ocean climate modelling dataset analyses in ASPACE use a well established
technique to detect the emergence of a climate change signal (Hawkins and
Sutton 2012)". This technique (spatial random-effects meta-analysis, Queiros et
al. 2021)2 has been extensively used in marine climate change studies around
the world in the last decade®®4567:32: it builds on decades of development of
statistical analyses methods in the medical literature, which have been more
recently used in environmental sciences, and then adapted to the analyses of
ocean climate change time-series?
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Figure 1: The patterns of change in different

Essential Ocean Variables over time and space,

contrasting the period 2006-2025 with 2055-
2074, using the standardised mean difference
estimator Hedges’ g. Base data is (Kay et

al. 2020), providing estimates under global
emissions trajectory RCP8.5. a) sea surface
temperature; b) sea surface dissolved oxygen;
c) sea surface salinity; d) phytoplankton
(carbon) biomass. Green is where a variable
trend is consistent with the expected climate
change trend, pink expresses the opposite
trend, and white shows no change from the
present period.
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Ocean variables i.e. the physical, biogeochemical and biological components
of marine ecosystems - vary in space and time due to natural cycles and
man-made change®. Attributing the cause of those changes to climate

change requires first an estimation of what is the expected natural variability
for each variable: for instance, how much should temperature change due

to seasonal and interannual variation, and climate oscillations. It is then
necessary to estimate if estimated variability in a variable over the period of
analysis exceeds natural variability, and then whether the trend of change

in each variable (if any) is consistent with the expected long-term climate
change trend for that variable, in that region. Additionally, different ocean
conditions express climate change with different speed and magnitude (Figure
1; IPCC 2021)'° and different species also respond to all of those changes

with different speeds and magnitudes (Poloczanska et al 2013)™. Therefore,
determining which areas of the ocean are more sensitive or more resilient to
climate change is challenging, if we consider each ocean variable separately.
This attribute makes it difficult to make decisions about how to use marine
space sustainably in order to promote resilience for nature and people into the
future. Ecosystem and community level metrics of ocean change are therefore
required, that provide a broader picture of climate change for a particular
region of the ocean for which management is required.

Resolving this challenge, ASPACE uses spatial random effects meta-analysis
(SRMA) to analyse ocean climate modelling datasets. SRMA has been
designed specifically, and widely deployed, to support marine spatial policy
design to provide outputs that summarise the emergence of a climate signal
across considered variables. Specifically, this method is used to estimate

an objective ecosystem- or biological community-level quantification of

the impacts of climate change over a region of interest, instead of the need
to consider potentially different spatial and temporal patterns of change

in different ocean variable separately, whilst accounting for the natural
variability of individual variables.

Ocean climate modelling data selection

The starting point for the SRMA is for the user to select which ocean
modelling datasets they want to analyse. These usually take the form of 4D
modelling time-series, providing estimates for a particular ocean variable (e.g.
temperature, the biomass of a given species...) over space and time. The user
can select as many variables as they deem necessary to estimate the impact
of climate change in a given ecosystem component (e.g. benthic habitats,
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pelagic megafauna)® or marine activity sector (e.g. pelagic fisheries, seabed
aquaculture)® The selection of datasets should be done by or with end-users.

Inclusion of variables in each analysis requires that the user knows what is
the expected climate change trend for that variable. For instance, temperature
will warm as a result of climate change; species A is expected to decline due
to ocean warming; pH is expected to decline due to climate change. This
information on the direction of the trend is required by the SRMA algorithm in
ASPACE, and should be gathered via literature review. In this absence of this
information we advise that the user does not include a particular variable in
the analysis, as this will lead to spurious results.

Ocean climate modelling data analysis
SRMA then has two steps, and these are implemented in ASPACE using the
method previously described here.2

In the first step, the SMRA algorithm calculates the change in each individual
modelling datasets considered, in the time-period of analysis. Specifically,
change will be calculated for each variable, comparing two time periods:

the present and as many future periods and the user requests. To account

for natural variability (seasonal, interannual and climate oscillations) when
determining human-induced climate change from the observational record, the
Intergovernmental Panel on Climate Change, in its Sixth Assessment Report
(ARG), assessed changes over 20-year periods (IPCC 2021). In line with this, in
ASPACE, we consider the “present” as the 20 year period from 2006-2025, and
the future as any 20 year time period, from 2026 onwards to the end of the

21st century: 2026-2045; 2027-2046; etc. In this way, the mean value of ocean
variables is estimated over 20 year periods, and comparisons are only possible
for time periods which are at least 20 years apart.

The variable produced in this first step of the analysis is called Hedges” g
(individual effect) and expresses the mean local change in each individual
variable (e.g. bottom seawater temperature), relative to their variability in

both the present and the future period, as necessary to determine whether its
change within the period of analysis is in agreement or beyond its expected
natural variability. The calculation for each variable is set up so that a negative
Hedges’ g expresses a change consistent with the expected long-term climate-
driven trend, while a positive value indicates the opposite trend. In Figure 1,
mean climate-driven trends were defined based on literature review and can
be found elsewhere (Queirds et al. 2023). Hedges’ g estimated for each variable
in each time-period comparison can be visualised in the Project Outputs
dashboard, providing a heatmap that has the same scale across all variables,
given that Hedges’ g is a standardised measure that accounts for each
variable’s mean and variability in the present and each future period.

In the second step, change across all variables in each analysis (and for each
modelling scenario and time-period) is estimated. This is called the summary
effect (or M). M is estimated with a mean value and variance. Based on both,
we can then classify areas of marine space based on whether the mean value of
M is large and positive with low variance, large and negative with low variance,
or whether it has a value close to zero and/or high variance (full details in
Queirds et al. 2021). The final classification of areas is then:
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l. Climate change hotspot areas where M is large and negative, with
narrow variance. In these areas, variable trends are consistent with
expected climate change effects, and trends often exceed the natural
variability of each variable. These sites are seen as being sensitive to
climate change and indicate areas where MPAs or other conservation
mechanisms are likely to become less effective, or ineffective, within the
period of analysis. Target species may experience a shift in distributions
away from these areas.

Il Climate change refuge areas where M is close to zero and/or has
large variance. In these areas, ecosystem change is overall small and/
or change across various ecosystem or community characteristics
is not overall in line with expected climate change impact trends. In
these sites, climate change is therefore seen as milder, and species are
expected to experience many conditions that will be similar to present
time. We expect therefore that present uses of space in these areas
would be by and large similar within period of analysis.

M. Bright spots areas where M is large and positive, with narrow variance.
In these areas, variable trends are often or all contrary to the trend
expected from climate change effects, and they exceed the natural
variability of each variable. These areas may also be particularly
important sites where focal sectors may be sustainable in support of
overall climate change adaptation.

Tau-squared ({?) is also calculated during the calculation of M, giving the
between model variance, and is calculated using the DerSimonian and Laird
method (Borenstein et al. 2009)™. Regions of higher {2 indicate areas where the
trends between variables disagree (i.e. where Hedges’ g are most different) whilst
2 will be closer to zero where they are more consistent. Observing the variation

of {2 is important especially where areas are classified as climate change refugia,
as its value provides insight into whether M is classified as not significantly
different from O because: 1) many variables are within their natural variability
(true climate refuge); or whether 2) that classification emerges because several
variables express divergent trends (transitional refuge).

Ocean climate modelling data analysis output

Hedges’ g, M and {? estimated in each time-period and scenario comparison can
be visualised in the Analysis Outputs dashboard. The outputs take the form

of heatmaps for Hedges’g and {? (Figure 2). Hedges’ g can be compared across
variables within a given analysis, whereby the more the g departs from O, the
stronger the change in the variable relative to the present period. This is because
Hedges’ g is a standardised effect size measure that accounts for each variable’s
mean and variability in the present and each future period, as well as for {2

If the analysis output selected for visualisation is M, this can be visualised using
two possible options: per future 20 year period; or in “High Agreement”. In these
two outputs, the three classes (refuge, hotspot and bright spot) are identified
with different colours (Figure 2), and they can be visualised together or separately.
The High Agreement option is estimated by counting in how many future time
slices (from the ones selected by the user) each model domain cell is classified

in a particular class (refuge, hotspot or bright spot) over the whole period of
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Figure 2: Example of ocean climate
modelling data analysis outputs: Hedges’
g (top), M (middle) and t? (bottom). The UK
EEZ has been added as a GIS layer overlain
on M in the middle plot (blue).In all plots,
the region of analysis is shown by the edge
of the variable values. Analysed modelling
data is Kay et al. 2020, providing estimates
under global emissions trajectory RCP4.5

CORE FEATURES AND FUNCTIONS 87

analysis. “High agreement” provides the class that each cell falls into in at least
80% of future time slices chosen by the user for analysis. This provides a view

of long-term change in the region of analysis and of the stability of the climate
change sensitivity classification. The longer a particular area falls within one of
the 3 classes of sensitivity to climate change, the more confident a user can be of
the outcome of spatial interventions in that area. Areas where a cell does not fall
into any particular category in at least 80% of future time slices are not classified
as any of the three categories when the option selected to visualising M is “High
Agreement”. In those areas, only the background map is seen.

Any GIS layers available through ASPACE or uploaded by the user can be overlain
onto the ocean climate modelling data analysis output (Figure 2, middle panel).
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4.2 Alternative spatial management scenarios

The aim of ASPACE is to allow users to explore and identify opportunities for
climate-smart marine spatial management via the development of alternative
spatial management scenarios (ASMS). These scenarios are mathematical
solutions for the use of marine and coastal space that make use of climate-
resilient areas (identified in 4.1) towards a specific spatial management

goal set out by the user. The way the user creates a scenario is by using the
“Optimisation” feature.

The Optimisation feature currently selects regions of Refugia and Brightspots
when considering climate resilient areas. In future, users will be able to define
which areas are involved in calculations.

The Optimisation feature has two options:

1. Climate resilience of current areas: in this mode, the user is comparing
the outputs of the Ocean Climate Modelling Analysis (4.1) with one (primary)
or more (secondary) GIS layers that describe one or more marine sectors
(e.g. an MPA network; the national distribution of aquaculture facilities), or
species and habitats (e.g. the distribution of Priority Marine Features), as
they are currently distributed in the present. The output of this Optimisation
is the identified area of the selected marine sector (s) that is climate-
resilient. This type of ASMS therefore represents the status quo, if no
changes are made to marine sector distributions, and is sometimes referred
to as the Business as Usual scenario.

2. New areas to increase sectorial climate resilience: in this mode, the
user is building on the outputs of the Ocean Climate Modelling Analysis
(4.1) to find new areas that could be used to increase the climate resilience
of one (primary) or more (secondary) marine sectors (s) or habitat(s),
based on used GIS layers selected during Optimisation. The output of
this optimisation is the new area(s) that could be used to meet that
management goal. During this type of optimisation, ASPACE seeks areas
based on a given threshold for the size of the sector we want to it to increase
by (e.g.10%). Those areas may include areas where compatible marine uses
occur, and ASPACE will avoid areas where incompatible activities take place
- both of which are set by the user as secondary “inclusive” or “exclusive”
sectors. This type of ASMS therefore represents a climate-smart scenario,
as its output identifies changes to spatial management (i.e. new areas) that
address climate change.

ASMS using the same Ocean Climate Modelling Analysis and more than one
Optimisation Pathway can then be compared using the “Compare Results” tab
of the Optimisation dashboard. ASMS are compared based on the provided
information about the area of explored sector that is climate-resilient, as well as
estimates of how each scenario affects the economy of concerned regions and
how it aligns with the values of their stakeholders (see Sections 4.3 and 4.4).
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Table 2: List of economic and
social metrics estimated by the
ASPACE economic model
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4.3 Scoring alternative spatial management
scenarios using economic modelling

Overview

The economic results generated within the ASPACE tool illustrate how changes
in activity in one sector affect not only that sector, but also the wider economy
through supply chain linkages. This perspective enables users to assess and
compare Alternative Spatial Management Scenarios (ASMS) using a common
set of economic indicators (which also translate to social and climate change
indicators in some cases), without relying on detailed or highly uncertain
economic forecasts.

In practical terms, the economic modelling component of ASPACE represents
the economy in the region of interest as a system of interconnected marine
activity sectors. The model employs a macro-economic technique approach
called Input-Output (I0) Economic Modelling, and uses real world data (i.e.
Input-Output tables) published by individual nations, which the ASPACE team
has further refined for the marine environment. In ASPACE v1.0 this feature

is only available for the UK and individual UK nations, based on published
evidence (Roca-Florido and Mair, 2024; Roca-Florido et al, 2025)™15. In future
versions, this feature will be available for other regions of the world, and users
will also be able to upload their own |10 economic model.

Methodology and workflow in ASPACE

When an ASMS is created in using the option New Areas to Increase
Sectoral Climate Resilience, ASPACE searches for new areas that could be
used to increase the climate resilience of a particular sector (s), or ecosystem
component(s). The optimisation pathway is configured considering how that
particular variable chosen by the user can or cannot share space with other
marine space(s), as selected by the user. This will lead to changes in how
user-selected marine activity sectors use space. Specifically, the sector for
which ASPACE is seeking new areas, and those (any) for which activity may
now be restricted as a result. This pathway is taken into the economic model
through an adjustment in the size of economic activity of selected sectors,
with repercussions to other marine economy sectors directly and indirectly
linked to these target sectors, though the Input-Output model (“I10 model”).

Economic Modelling Output

Units Description

Greenhouse Gas Emissions

Thousand tonnes GHG emitted per £ million changed in gross output
in the relevant sectors

Gross Value Added

£ million GVA generated for each £ million changed in gross
output in the relevant sectors

Labour Compensation

£ million Income generated for each £ million changed in
gross output in the relevant sectors

Number of People Employed

Workers Jobs created for each £ million changed in gross
output in the key sectors
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Metric so0272 so0271
General
ASMS Type multiple_sector existing_climate_resilience
Case Study Site uk_case_study uk_case_study
Climate
Desired (%) 30
Tolerance (%) 2
Within tolerance bounds? No
Optimised (%) 052%
Optimised additional (km?) 2232.587026592091
Required additional (km?) 127760.90653365015
Lower limit (km?) 125205.68840297715
Upper limit (km?) 130316.12466432316
Gas -~ ASMS (Tt of Tonnes) 9900 1000.0
Gas = BAU (Th of Tonnes) 1000.0 1000.0
Gas i -Change ( of Tonnes) 100 oo
Economic
Gross Value Added - ASMS (EM) 1300.0 1400.0
Gross Value Added - Change (EM) 1000 00
Labour Compensation - ASMS (EM) 7600 7700
Labour Compensation - BAU (EM) 7800 7800
Labour Compensation - Change (EM) 200 100
Number of People Employed - ASMS 220000 22000.0
Number of People Employed - BAU 230000 23000.0
Number of People Employed - Change 1000.0 1000.0

Social
Social Scoring - ASMS.

Social Scoring - BAU

Figure 3: Example of comparison of 3
ASMSs using all metrics estimated by
ASPACE. 1 line scenario descriptions
are given as header names. This
feature can be used to compare ASMS
within the same Project: it is accessed
using the Compare Results button
within the Optimizations dashboard

This approach then leads to the calculation of economic and social

metrics for the ASMS (Table 2) that reflect a an economy wide view of the
consequences of spatial management decisions, rather than focusing solely
on individual marine space uses or industries.

Metrics estimated for generated ASMS using this feature can then be used to
compare multiple ASMS for the same Ocean Climate Modelling Project, using
the button Compare Results from a particular Project’s Optimisations List.
The metrics estimated by this feature (Table 2 and Figure 3) are then provided
side-by-side for the different ASMS compared, alongside climate change
metrics and the score for alignment with stakeholder values metric. At this
stage of the ASPACE workflow, the aim is not to predict short term economic
performance of individual ASMS, but to compare multiple ASMS in terms of
their broader climate-resilience, and their economic and social implications.
This enables the user to make an explicit assessment of a balance of
trade offs, such as balancing improvements in climate resilience with
the maintenance of economic activity or employment.

The baseline scenario is estimated first to provide a reference point for
comparison and to define the initial indicator values. It represents total output
based on all species harvested and landed at port in the region, regardless of
where fishing takes place.

The Business as Usual scenario assumes that fishing activities can occur
across the entire marine plan area in the region of interest. It accounts for
capture losses associated with climate change hotspots (and thus economic
loss), irrespective of the fishing gear used or the species targeted.
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For simplification, in ASPACE v1.0, when an ASMS seeks to increase the area

of a Marine Protected Area network by adding ecologically and biologically
meaningful climate-resilient areas, these areas are assumed to not allow for
any fishing activity. The ASPACE team acknowledges this assumption is not
always valid, as different types of restrictions apply to different conservation
site types. In future release versions, the user will be able to select whether this
assumption should or should not be applied during Optimisation.

The effects associated with each ASMS are expressed as deviations from
Business as Usual, enabling the user to compare ASMS on a common and
internally consistent basis (e.g. Figure 3).

Important

+ Metrics can only be estimated using this feature if a Marine Spatial Planning
area (or Marine Planning Area in the UK) is selected by the user as one of the
Additional Constrains during Optimisation. The user must therefore ensure they
have selected this GIS layer (which may require uploading their own GIS dataset
for their region) to be able to use this feature. Please refer to the Quick Start
Guide (Section 3) to find out how to use a Marine Plan area during Optimisation.

« In ASPACE v1.0, this feature generates metric estimates after the spatial
constraints solution has been found by the tool. In future versions, the tool will
allow the user to select the maximisation of this feature’s outcome as one of
the criteria driving the solution finding algorithm during Optimisation.

+ All ASMS metrics (climate-resilience, economic and social) are comparable
only for ASMS generated from the same Ocean Climate Modelling analysis
output: i.e. different Optimisations within the same Project.

+ The resulting social and economic metric estimates (e.g. Table. 2) are intended
to support comparison of ASMS rather than to deliver precise predictions for
individual ASMS.

« For simplification, in ASPACE v1.0, when an ASMS seeks to increase the area
of a Marine Protected Area network by adding ecologically and biologically
meaningful climate-resilient areas, these areas are assumed to not allow for
any fishing activity. The ASPACE team acknowledges this assumption is not
always valid, as different types of restrictions apply to different conservation
site types. In future release versions, the user will be able to select whether this
assumption should or should not be applied during Optimisation.

- In ASPACE v1.0, changes to the size of the area accessible to fishing are the
primary driver of the economic model used, with repercussions estimated
based on how the fishing sector relates to other sectors directly or indirectly.
ASPACE v2.0, with planned launch for Autumn 2026, will include the wind
sector also as a primary driver of the economic model.

Differences between ASMS highlight how strongly economic activity,
employment, income, and emissions are linked to particular spatial distribution
of marine sectors. For example, an ASMS in which climate change hotspots
reduce the area available to certain fishing fleet segments may lead to lower
fishing activity in the area of analysis, which is then estimated by the 10 model.
These reductions can then affect related sectors within the model, such as
processing, storage, and transport. By contrast, scenarios that redirect activity
of that fishing fleet towards more climate resilient areas, such as bright spots or
refugia, may generate stronger economy wide effects per unit of activity, which
will be captured in the ASMS metrics.



ASPACE USER GUIDE CORE FEATURES AND FUNCTIONS 92

Clear documentation of data sources used, assumptions
made by the tool, and user decisions are therefore essential
when results are used for reporting or decision making.

Interpreting the results of this feature

Care is needed when interpreting these results. Tool assumptions are applied
consistently across all ASMS compared. For instance, changes in activity of a
sector are assumed to be proportional to changes in available area to the sector
in the region of analysis, such that a reduction or expansion in spatial access

is assumed to lead to a corresponding reduction or increase in sectoral activity.
These results should also be interpreted at an appropriate level of aggregation, as
economy wide indicators may mask variation across individual sectors or smaller
locations within the region of analysis.

The results from this feature should always be considered alongside the other
metrics estimated by ASPACE when comparing ASMS (Fig. 3). ASPACE is designed
as an integrated decision support tool, and economic performance alone does not
capture all relevant dimensions of spatial management choices. Clear docum-
entation of data sources used, assumptions made by the tool, and user decisions
are therefore essential when results are used for reporting or decision making.

Finally, the economic modelling approach used in ASPACE v1.0 relies on fixed
relationships between sectors based on the stated refences and does not account

for changes in prices, input substitution, or behaviour. Production structures are
assumed to remain unchanged over the time of analysis. Outputs should therefore be
interpreted as indicative estimates of structural impacts rather than exact forecasts.
Within these limits, this feature provides a robust and internally consistent basis

for comparing ASMS and for understanding their broader economic, social, and
environmental implications within the ASPACE framework, that should be of use to
Sustainable Ocean Planning and other marine spatial management mechanisms.

4.4 Scoring alternative spatial management
scenarios using stakeholder values

Alignment of ASMS with social values is currently estimated for individual
scenarios, when the Planning objective used in a Project’s Optimisation
dashboard is set to New areas to increase sectorial climate resilience.

IMPORTANT

» In ASPACE v1.0, we provide estimates of how marine planning stakeholders
perceive different attributes of marine space in the UK only, as collected
during the MSPACE project (https://www.smmr.org.uk/funded-projects/
marine-spatial-planning-addressing-climate-effects). A detailed methodology
for the stakehodler values assessment can be found in Reinhardt and
Danahey Janin 2025, with results presented in Talbot et al. 2025a-d"-812:20,
Depending on where the region of interest the user selects is located when
they set up a new Project, ASPACE will use different stakeholder values
matrices. In future ASPACE version releases, we will allow the user to
customise a stakeholder values matrix, based on new inputs (e.g. resulting
from new research, or stakeholder consultations).


https://www.smmr.org.uk/funded-projects/marine-spatial-planning-addressing-climate-effects/
https://www.smmr.org.uk/funded-projects/marine-spatial-planning-addressing-climate-effects/
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+ The estimated scores for a set of ASMS are comparable within the same Project,
but not between different Projects

« Inorder to estimate how a particular ASMS aligns with stakeholder values,
ASPACE must be setup such that GIS layers involved in ASMS generation and
particular attributes of marine space that stakeholders have scored are mapped
to each other. Specifically, the primary sector layer selected in Optimisation
must be mapped to the correct GIS layer types, which are internally linked to the
stakeholder value matrices. When users upload new GIS datasets (or layers) to
ASPACE, they are invited to assign tags to these, which are used in the internal
mapping between data and values matrices. In this way, this new GIS data can
be used in subsequent ASMS generation in Optimisation. These layer types are
therefore linked to marine activity sectors or habitat components that should
feature in a dedicated stakeholder value assessment engagement activity.
An example of some of the tags available are: “Tourism”, “Cultural Heritage”
and “Recreation”. The first part of the assessment involves weighting the
stakeholder values in the case study area across all sectors. These weights are
then multiplied by any percentage change in the tagged primary sector layer
due to the ASMS scenario generation to give a social score value.

The first part of the ASMS social scoring involves weighting the stakeholder
values in the case study area across all sectors, based on the correct stakeholder
values matrix, i.e. that which best represents the region of interest. These weights
are then multiplied by any percentage change in the tagged primary sector layer
due to the ASMS scenario generated, to give a social score value.

The estimated scores for a set of ASMS are comparable within the same
Project, but not between different Projects, such that, for the same region of
interest selected within a Project:

+ The Business as Usual scenario (“BAU”, see section 4.3) is scored 0, as the
central point for ASMS comparison.

- Larger, positive scores indicate an ASMS aligns better with how stakeholders
value marine space than the BAU.

- More negative scores indicate an ASMS aligns less well with how
stakeholders value marine space than the BAU.

 The final social score of individual ASMS can be visualised in the Compare
Results table, accessible from the Optimisations dashboard, and exported
for further uses.

4.5 Features in development
We are always improving the ASPACE platform. Here are some exciting things
that we are working on that will be in the tool soon:

- Users to choose which regions from Refugia / Brightspots / Hotspots they
want included in the ASMS creation

+ Wind in economic model (see section 4.3)

+ Relaxing no take zone assumption in Optimisation (see section 4.3)

- Users to have the ability to upload Economic Modelling Data

- Users to have the ability to upload Social Values

+ Multi-sector ASMS optimisations

- “Integration with the Offshore Renewable Impacts on Ecosystem Services
(ORIES) project. This will be added as part of the funded EQUIFy project.



Frequently asked
questions

What is the ASPACE Tool?

ASPACE is an assisted spatial prioritisation software conceived to support
the design and exploration of climate-resilient, socially acceptable and
economically viable marine spatial policy intervention scenarios. It combines
climate change modelling analyses, stakeholder value assessment, and
economic modelling together in an integrated, transdisciplinary, fully
interactive tool, designed to help meet the needs of policy makers and other
practitioners, as well as of researchers.

Do | need to install any software to use the tool?

No. The ASPACE Tool is fully web-based and does not require any additional
software or plugins. It can be accessed using any modern Chromium-based
web browser, such as Google Chrome or Microsoft Edge.

Is the tool free to use?

Yes! All you need to get started is a new account. Since we don’t have a roadmap
for adding subscription/paid services yet, we can always change in this with
future releases.

What are the network requirements?

A stable internet connection is required. The tool operates over standard HTTPS
(port 443). Institutional firewalls or proxies must allow outbound HTTPS access
to the ASPACE domain.

Where can | find or download the User Guide?
You can download the full ASPACE User Guide as a PDF from the following link:

How do | create an account?

Click Sign Up on the ASPACE login page and
complete the registration form with your name, email address, company and
country. Once submitted, you will receive an email to verify your email address
and activate your account.


https://mspace.ac.uk/media/ASPACE_User_Guide.pdf
https://mspace.ac.uk/signup/
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Do | need institutional approval to sign up?

No. The ASPACE Tool is open for users to create an account directly.
However, access to certain datasets or features may depend on project or
administrator permissions.

I didn’t receive the sign-up verification email. What should | do?
Please check your spam or junk folder first. If the email does not arrive within a
few minutes, contact aspace@pml.ac.uk.

What personal data does ASPACE collect?

Basic account and usage information (e.g. name, email address, organisation,
country, login details, and platform activity). Please read the Privacy Policy for
further details.

Are cookies used?
Only essential cookies required for secure operation. No marketing cookies
are used. Please read the Privacy Policy for further details.

How long is my data kept?

Personal account data is retained only as long as necessary and is deleted or
anonymised after inactivity, in line with policy requirements. Please read the
Privacy Policy for further details.

How do I sign in to ASPACE?
Go to the ASPACE login page (https://mspace.ac.uk/login), enter your registered
email address and password, and click Sign In.

What should I do if | forget my password?

Click “Forgot Password?” (https://mspace.ac.uk/forget_password) on the login
page and follow the email-based password reset process. If you do not receive
the reset email, contact the system administrator aspace@pml.ac.uk.

Why can’t | sign in even though my password is correct?
This may happen if:

« Your email address has not been verified

« There is a temporary system issue

 Please check your email for activation messages or contact
aspace@pml.ac.uk if the issue continues.

What is 2FA and why is it used?

Two-Factor Authentication (2FA) adds an extra layer of security by requiring a
one-time verification code sent to your email after you enter your password.
This helps protect your account from unauthorised access.

When is the 2FA email sent?
A 2FA verification email is sent each time you sign in after entering your correct
email address and password.


mailto:aspace%40pml.ac.uk?subject=
https://mspace.ac.uk/login
https://mspace.ac.uk/forget_password
mailto:aspace%40pml.ac.uk?subject=
mailto:aspace%40pml.ac.uk?subject=
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I didn’t receive the 2FA email. What should | do?
« Check your spam or junk folder

- Wait a few minutes and try again

« Try Resend Code

- Ensure your email inbox is not full

If the issue persists, contact the system administrator.
Can | disable 2FA?
No. Email-based 2FA is enabled to maintain a consistent security standard

across all ASPACE accounts.

Please contact your IT Department to allow emails from
notifications@mspace.ac.uk and aspace@pml.ac.uk.

Does ASPACE store my password?

Yes, to allow the password function, each password is stored in an encrypted
and hashed form which cannot be accessed by the system administrator.

Who owns the data | upload?

9.5 Copyright You retain ownership of your data. By uploading, you grant PML a
and data non-exclusive, royalty-free licence to host and process the data solely to
ownershi P operate the ASPACE platform.

Can ASPACE or other users reuse my uploaded data?

Other users can use your data within the ASPACE framework only if you have
made it available as a shared dataset. The use of data on the platform is
regulated by our Privacy Policy and Terms and Conditions

What licence applies to ASPACE-provided content?
ASPACE content is provided under a Creative Commons Attribution-
NonCommercial-ShareAlike 4.0 licence, allowing reuse for non-commercial

purposes with attribution.

What happens if copyrighted material is uploaded without permission?
If notified, PML will temporarily remove the content, investigate, and take
appropriate action. Users are responsible for ensuring they have permission to

upload data.
5.6 Performance How long does it take the tool to run meta-analysis and Alternative
and processi ng Spatial Management Scenario (ASMS)?

Processing times depend on the size of the study area and the number of
datasets selected:

- Initial meta-analysis of ocean climate modelling data can take up to one hour.
« Optimisation of an ASMS typically takes up to 10 minutes.

All processing runs on secure servers at Plymouth Marine Laboratory. You will
receive an email notification once processing is complete, and you may safely
close your browser after starting a run.


mailto:notifications@mspace.ac.uk
mailto:aspace@pml.ac.uk
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What does the Optimisation do?

The optimisation engine helps users design spatial solutions, such as
identifying priority areas for conservation or balancing protection with human
activities. It uses user-defined constraints, spatial layers, and numerical
thresholds to explore ASMS.

Can | export results for external use?
Yes. Processed outputs as maps (such as GeoTIFFs and shapefiles) or results
tables will be available for download.

My upload failed. What should | check first?
Check the following as mentioned in the User Guide:
- Files are inside a ZIP archive

- Filenames follow the required convention

« All required files are present
« Headings in model data matrices removed
+ Spatial dimensions are consistent

Why does my map look shifted or misaligned?

« Common causes include:

« Incorrect Coordinate Reference System (not EPSG:4326)
—Wrong longitude/latitude values
—Mismatch between grid dimensions and coordinate ordering

Who do | contact for help or legal issues?

« Admin support: aspace@pml.ac.uk

« Copyright or legal concerns: legal@pml.ac.uk

+ Raise Ticket: https://mspace.ac.uk/create-ticket


mailto:aspace@pml.ac.uk
mailto:legal@pml.ac.uk
https://mspace.ac.uk/create-ticket
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ASPACE is an assisted spatial prioritisation software
conceived to support the design and exploration of
climate-resilient, socially acceptable and economically
viable marine spatial policy intervention scenarios. It
combines climate change modelling analyses, stakeholder
value assessment, and economic modelling together in

an integrated, transdisciplinary, fully interactive tool,
designed to help meet the needs of policy makers and
other practitioners, as well as of researchers.

ASPACE is a free, web-based tool, that can be used in

any marine and coastal region where suitable datasets
are available. ASPACE provides a number of datasets to
enable users to carry out analysis in some regions of

the world, but users can also upload their own datasets.
Data uploaded by users can be private or shared with the
ASPACE community. As the ASPACE community grows, our
mission is to grow capability to manage our ocean around
the world in more sustainable and climate-resilient ways,
for future generations.

ASPACE

Plymouth Marine
Laboratory, Prospect Place,
Plymouth, PL1 3DH

+44 (0)1752 633 100
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